Preface – News in version 7.4

• Autodesk Spark (Beta): A button for direct Upload to Spark was added to the iconbar
• Autodesk Spark (Beta): Performance optimizations
• Bugfixes

Preface – News in version 7.3

• Slice commander: An animation of the toolpath can be displayed in the slice view
• Autodesk Spark (beta): Files can be uploaded and downloaded from and to Autodesk Spark
• Part alignment: Animation for the alignment can be switched off now
• Bugfixes

Preface – News in version 7.2

• Bugfixes

Preface – News in version 7.1

• Bugfixes

Preface – News in version 7.0

• Mesh Viewer has been removed: Textures and colors are now displayed in default viewing screen
• 3MF file format is now fully supported (with colors and textures) by Linux and Mac versions of netfabb. Windows can import files according to the 0.93 specification of 3MF, all versions can import 3MF files according to specification 1.0. Export is always version 1.0.
• Bugfixes
Content

Preface – News in version 7.4 ................................................................. 2
Preface – News in version 7.3 ................................................................. 2
Preface – News in version 7.2 ................................................................. 2
Preface – News in version 7.1 ................................................................. 2
Preface – News in version 7.0 ................................................................. 2

1 STL Files and Triangle Meshes ............................................................ 8
   1.1 Validity ..................................................................................... 10
   1.2 Closedness ............................................................................. 11
   1.3 Orientability ........................................................................... 12
   1.4 Self-Intersections ................................................................... 13

2 Program Overview ............................................................................. 14
   2.1 The Project Tree ....................................................................... 16
   2.2 The Viewing Screen .................................................................. 18
   2.3 Program Control ....................................................................... 21
   2.4 The Platform ............................................................................ 22
   2.5 File Format Overview (partially in netfabb Private/Pro only) .......... 23
   2.6 All Shortkeys (partially in netfabb Private/Pro only) .................... 25

3 Project Management .......................................................................... 28
   3.1 Start Project ............................................................................. 29
   3.2 Open Files ............................................................................... 29
      3.2.1 Open ................................................................................. 29
      3.2.2 Add Part ........................................................................... 29
      3.2.3 File Preview Browser ........................................................ 33
      3.2.4 Create Report Sheets (partially in netfabb Private/Pro only) .... 34
   3.3 Save and Export ....................................................................... 38
6.2.1  Invert Part ................................................................. 79
6.2.2  Mirror ................................................................. 79
6.2.3  Convert Units .......................................................... 80
6.3  Create Shell ............................................................... 80
6.4  Simple Cutting .......................................................... 83
6.5  Extrude ................................................................. 86
6.6  Distort Section ............................................................ 87
6.7  Color and texture .......................................................... 87
6.7.1  Coloring .............................................................. 88
6.7.2  Texturing ............................................................. 90
6.7.3  Add advanced texture ............................................. 92
6.7.4  Texture imposing ................................................... 96
7  Part Repair (partially in netfabb Private/Pro only) ......................... 98
7.1  The Repair Module .................................................... 98
7.2  Repair Viewing Options ................................................ 100
7.2.1  Zoom and visualization ............................................ 100
7.2.2  Hide selected surfaces ............................................. 101
7.3  Selection ................................................................. 102
7.4  Manual Repair (partially in netfabb Private/Pro only) ................. 108
7.5  Semi-Automatic Repair ................................................ 111
7.5.1  Self-Intersections .................................................... 114
7.5.2  Stitch Triangles ...................................................... 115
7.5.3  Fix Flipped Triangles ................................................. 116
7.5.4  Remove Double Triangles ........................................... 117
7.5.5  Select Overlapping Triangles ...................................... 117
7.5.6  Remove Degenerate Faces .............................................................. 118
7.5.7  Refine triangle mesh ................................................................. 118
7.5.8  Extract Selected Triangles As Part ............................................... 118
7.5.9  Split Non-Oriented Edges ............................................................ 119
7.6    Automatic Repair (partially in netfabb Private/Pro only) .................. 120

8  Measuring and Quality Assurance ...................................................... 122
8.1    The Measuring Tool ................................................................. 122
8.1.1  Cutting Lines ................................................................. 125
8.1.2  Setting Anchors ................................................................. 125
8.1.3  Measure Distance ................................................................. 127
8.1.4  Measure Angles ................................................................. 129
8.1.5  Measure Radius ................................................................. 130
8.1.6  Add Note ................................................................. 131
8.1.7  Set Default Modes ................................................................. 132
8.1.8  Lock and Unlock View ............................................................. 133
8.2    Test ................................................................. 133
8.2.1  Create Definition ................................................................. 134
8.2.2  Test Result ................................................................. 136
8.3    Interlocking test ................................................................. 136
8.4    Test for Z-removability ............................................................. 137

9  The Slice Commander (partially in netfabb Private/Pro only) ............... 139
9.1    The Slicing Process ................................................................. 139
9.2    The Slices Section ................................................................. 140
9.3    Active Slice File ................................................................. 141
9.4    Slice Selection and Handling .................................................. 142
1 STL Files and Triangle Meshes

The STL-format is the industrial standard for handling triangulated meshes. STL-files contain a plain list of three-dimensional corner point coordinates and flat triangles. The triangles, also referred to as faces, are defined by three corner points and have an inside
and an outside. Adjacent triangles may use common corner points and share the same edges, which results in a coherent triangle mesh (Figure 1.1). The generality and simplicity of this concept makes STL-files compatible to a lot of applications.

Figure 1.1: Parametric Surface and Triangulated Representation

However, they do not contain any topological information about the mesh. This causes typical errors when CAD files with different file formats are converted to STL. The netfabb software is a specialized software to detect and repair these kinds of damages and create faultless meshes without holes, deformations or intersections. These meshes can then be converted into slice files ready for additive manufacturing. The STL format aims for a precise approximation of bodies in three-dimensional space. Although other CAD formats have advantages in that respect, a variety of applications need a surface representation consisting of flat triangles. These are:

- Accelerated rendering in multimedia applications
- Solving partial differential equations
- Computer aided engineering
- Rapid prototyping and additive manufacturing

However, a simple collection of triangles will not always create a solid body. For a good triangle mesh that can be used for 3D printing, the mesh has to be valid, closed, oriented and should not contain any self-intersections.
1.1 Validity

Two edges of adjacent triangles which lie on top of each other are only regarded as one edge, if they have equal end points. Thus, the simple mesh in Figure 1.2 consists of two triangles and has exactly five edges: four border edges and one interior edge. Border edges belong to only one triangle, while interior edges connect two triangles.

![Figure 1.2: A simple mesh with 5 edges: four border edges and one interior edge.](image1)

A mesh is only regarded as valid, if interior edges have the same corner points for both adjacent triangles. Only then, all neighboring triangles are connected by a whole interior edge (Figure 1.3, Figure 1.4). No neighboring triangles are split and a smooth topology is created.

This validity is an essential property of most calculations. If two edges have only one common corner point, they will be defined as two border edges, even if they are on top of each other.

![Figure 1.3: An invalid triangulation (left) compared to a valid triangulation (right).](image2)
1.2 Closedness

Parts can only be used for 3D printing, if their surface is closed. This means that there are no holes and no border edges. Every edge has to be attached to exactly two triangles and all neighboring triangles have to share an interior edge (Figure 1.5, Figure 1.6). Closedness may separate a mesh into several components called shells (Figure 1.7).

Figure 1.5: A closed surface (left) and a surface with holes (right)

Figure 1.6: Two disconnected (left) and two connected triangles (right)
1.3 Orientability

For the conversion of triangle meshes into slice data ready for 3D printing, it is vital that the parts are oriented correctly. The orientation defines the outside and the inside of a part. The orientation of a part is determined by the orientation of all triangles. The order of the points defining a triangle defines its orientation by the "right-hand-rule" (Figure 1.8). If the orientations of all neighboring triangles conform to each other and there are no flipped triangles, a closed shell separates between outside and inside. But if there are flipped triangles, this may not be possible. Thus, even closed parts may be faulty.

Figure 1.7: A mesh consisting of 60 disjoint shells.

Figure 1.8: The orientation of a triangle is determined by the order of its points.
1.4 Self-Intersections

Finally, the surface of a solid body should not contain any self-intersections. These occur whenever triangles or surfaces of one part cut through each other (Figure 1.9, Figure 1.10). For many applications, self-intersections are very impractical, especially if the mesh shall be processed further.

For most additive fabrication processes, three-dimensional data has to be converted into two-and-a-half-dimensional slice data. Here, self-intersections in the original data result in self-intersection in the slices. These might cause constructional failures or instabilities. Therefore, it is essential to remove self-intersections during the preparation of files.

*Figure 1.9: Self-Intersection: The two cubic shells cut through each other*
2 Program Overview

netfabb is a software tailored for additive manufacturing, rapid prototyping and 3D printing. It prepares three-dimensional files for printing and converts them into two-and-a-half-dimensional slice files, consisting of a list of two-dimensional slice layers. To help users prepare the print, it includes the features for viewing, editing, repairing and analyzing three-dimensional STL-files or slice-based files in various formats. All operations are conducted within projects, which can include any number of three-dimensional parts or slice files. The modular design of the software allows the use of different modules within a project, such as the repair module or the Slice Commander, which are linked to other user interfaces. Still, they can be executed simultaneously, as the user can switch between modules without any loss of information.

The user interface of the program is divided into the viewing screen, the menu bar and toolbar at the top and the context area to the right (Figure 2.1). By clicking on the bar between the viewing screen and the context area, the context area is hidden and the bar is pushed to the right edge of the screen. Another click on the bar will bring the context area back. By clicking on the edge of the bar and holding the mouse button, you can move the edge further into the screen by *drag & drop*.
In the top half of the context area, all parts and slices are listed in the **project tree**. The project tree can be used to get an overview over the project, organize files and to perform certain functions.

Most of the netfabb window however is occupied by the **viewing screen**, which visualizes the project and includes viewing options, positioning functions and a few basic handling options.

For the **control of the program**, functions can be found in context menus, tabsheets, the toolbar and the menu bar. Many of those functions can also be performed with shortkeys on your keyboard.

*Figure 2.1: An overview of the netfabb interface*
2.1 The Project Tree

The project tree lists all parts and slices of a project in a way similar to a directory tree. There are several sections, such as "Parts" and "Slices". The elements in the project tree can be sorted into groups, and they can have subordinate elements, such as a part repair or the measuring of a part. These are often connected to other modules. Subordinate elements of groups or parts are shown and hidden, if you click on the little Plus or Minus on the left side of the part (Figure 2.2).

![Figure 2.2: This project tree includes a group with the two parts "Pyramid" and "House". The grey eye indicates that the pyramid is hidden. The warning sign for the house indicates that it is damaged. A repair has been opened](image)

During work with netfabb, you can always switch between the different sections, elements and operations of the project by simply left-clicking on them in the tree. If you click on a sliced part in the slices section, netfabb will automatically switch to the Slice Commander and select the part you clicked on. If you click on a part repair, netfabb will automatically switch to the repair module of the superordinate part, including all previously conducted repair operations. That way you can conduct different operations at the same time, switching between them in the process.

Next to the part name, there is a percentage value. This value specifies the level of detail (see chapter 4.3) with which the parts are displayed in the screen.

By clicking on parts or slices, these are selected and can be worked with. If a part is selected and you hold Shift and click on another part, all parts on the list between the first
selected part and the part you clicked on are selected. By holding Ctrl and clicking on parts, those are either added to or removed from the selection.

When a part is damaged (inverted triangles or open triangle edges) or consists of more than one shell, you can see that immediately in the project tree. Damaged parts have a small caution sign at the bottom right of the colored dot next to the part name. Parts with more than one shell have a little box at the top right of the dot.

You can start certain operations in the project tree by moving elements into other directories by drag & drop (Figure 2.3). For example, if you move a part from the parts section into the slices section, a new, sliced part is created with certain parameters which you can enter in a dialog box.

![Project Tree Example](image)

*Figure 2.3: To slice a part, move it into the slices section with drag & drop. The blue bar indicates the place you drag an element to.*

Further functions available are activated by double-clicks on the little icons next to the name of objects. To the right side of the main sections, there is a little folder, by which you can add files to the project. With the round colored dot, you can change the color of the part. With the red X on the right side, the object is removed from the project. One click on the little eye hides or shows the object (Figure 2.4).

With the red X on the right side, the object is removed from the project. One click on the little eye hides or shows the object.

When certain features are active, other icons are added, such as a blue plus to add elements to the project or a green tick next to the repair directory to apply the repair. The numbers which are depicted on the right side of parts do not perform a function, but serve as auxiliary notes to keep an overview over projects containing a large number of parts.
Figure 2.4: Icons in the project tree preform certain functions of the program.

Many more functions of the software are available in the project tree via context menus, if you right-click on objects.

If you select Create new group in the context menu, you can create a group of elements as subdirectory of the respective section. You can add elements to groups by drag & drop. This helps you with the organization of the project, especially with enabling the simultaneous selection of several elements. Groups can be created both in the Parts section and in the Slices section of the tree.

2.2 The Viewing Screen

The viewing screen occupies the biggest section of the user interface. It provides the three-dimensional visualization of a project, including parts and (optionally) the platform. In the bottom left is a coordinate system indicating the current perspective from which you see the project. It shows the X-, Y- and Z-axis as well as the three planes between those axes. The size of the planes in the program vary, depending on the current perspective, with planes in the background always displayed larger than those in the foreground. The size of those planes can be changed in the settings (chapter 10). If the used file format supports the display of colors and textures, these will be visualized in the viewing screen.

There are several intuitive ways to edit the view or performing simple tasks in the viewing screen. The viewing perspective is changed by holding the right mouse button and moving the mouse in the direction you want to turn the project visually (see more in chapter 4.1).

You can also shift the view without changing the perspective, if you hold the central mouse button and move the mouse accordingly. If you do not have a central mouse button, for example on a laptop, hold Shift and the right mouse button.
To zoom in or out use the scroll button of your mouse. If you do not have a scroll button, hold Ctrl and the right mouse button and move the mouse up and down (Figure 2.7, see more in chapter 4.2).

The moving and rotating of parts is also conducted by drag & drop. You can move a part by left-clicking on the little green square in the middle of a selected part, holding the button and moving the mouse (Figure 2.5). If more than one part or a group is selected, all selected elements are moved. Furthermore, selected parts can be rotated in the viewing screen by clicking on the green brackets around the part, holding the left mouse button and moving the mouse in the direction of the rotation (Figure 2.6, see more in chapter 5.5).

*Figure 2.5: Use drag & drop to move parts.*

*Figure 2.6: Use drag & drop on the green brackets to rotate part.*
Figure 2.7: Change perspective and zoom with right mouse button and scroll button.

Below the screen, the **current mode** is specified, indicating which intuitive operation can currently be conducted with the mouse (default: Move/Rotate). If you change the mode, for example to "Align to Bottom Plane", other operations can be performed by the mouse (in this case a double-click on a surface of a part rotates the part to align that surface to the X-Y-plane).

Whenever operations are conducted that are performed in other modules, the viewing screen switches to special interfaces, for example to the repair screen, the slices screen, the measuring screen or the screen for Boolean Operations (figure 2.8). Intuitive control elements such as zooming in and out, changing perspectives and shifting the view are the same as in the standard interface.

Figure 2.8: Left: The two-dimensional view on the slice of a part in the slice commander. Right: A damaged part in the repair module.
2.3 Program Control

Apart from these intuitive handling elements in the viewing screen (as described above), there are several ways to use the program’s functionality, as most features can be found in several places.

Firstly, they are available via context menus, which are opened by a click with the right mouse button. The content of the context menus varies greatly, depending on where you click. It may differ with every section in the project tree, with a part in the viewing screen and empty space in the viewing screen, and with different user interfaces or modules (e.g. repair, measuring (figure 2.9 and 2.10).

![Figure 2.9: The context menus after right-clicking on the same part in the screen and in the project tree.](image)

The toolbar above the viewing screen offers many features with one mouse click. Again, the available functions in the toolbar depend on the current user interface. The repair module, for example, has a different toolbar to the normal screen (figure 2.11). Functions in the toolbar and context menus are also available in the menu bar. They are sorted into the menus "Project", "Edit", "Part", "Extras" and "View". In the "Settings" menu, you can...
change general options of the software (figure 2.12). In some modules, e.g. the repair, specific menus are added.

![Figure 2.10: The context menu after right-clicking on a part repair in the project tree.]

Additional functions are available in the **tabsheet** in the bottom half of the context area. Some features here cannot be found in the menu bar. In the default module, the tabsheet provides options for the cutting function, provides the dimensions of selected parts and tells you how many parts are selected and how many parts are shown or hidden. For many modules, such as the Boolean Operations module or the measuring tool, the options in the tabsheet represent the main features of the module (figure 2.13). This makes the tabsheet indispensable for the use of the program.

To create a smoother workflow, you can perform many functions with **shortkeys** on your keyboard. When you are working in the viewing screen, F2 starts the "Zoom to selection" mode, F5 provides the platform overview, F7 activates the "Align to bottom plane" mode and F3 switches back to the normal mode. Other shortkeys are specified in the description of the concerned function in this document.

### 2.4 The Platform

The platform is the three-dimensional area in the project which depicts the actual build platform of your machine. If you adjust the dimensions of the platform in the software to
your machine specifications, the six planes forming the platform represent the outer boundary of your print. The size of the platform can be changed in the settings.

![Image](image.jpg)

**Figure 2.13: Tabsheets of standard interface, repair module and Boolean Operations module**

In the settings, you can also choose, if you want to see the platform at all. If one or more parts are selected and you can also hold the ‘p’-key to display a virtual platform. It has the same origin coordinates as the selected part(s).

### 2.5 File Format Overview (partially in netfabb Private/Pro only)

In netfabb Professional, there are several file formats available for importing and exporting parts. With the Professional Tool CAD Import, there are even more possibilities. Different formats have different qualities, in the following table you’ll get a short overview:

<table>
<thead>
<tr>
<th>3D Format</th>
<th>Description</th>
<th>Import</th>
<th>Export</th>
<th>Import colors &amp; textures</th>
<th>Export colors &amp; textures</th>
</tr>
</thead>
<tbody>
<tr>
<td>STL</td>
<td>Surface Tessellation Language</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STL (Ascii)</td>
<td>Surface Tessellation Language</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STL (color)</td>
<td>Surface Tessellation Language</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>x3d</td>
<td>Extensible 3D-ASCII</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>x3db</td>
<td>Extensible 3D-Binary</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Gts</td>
<td>Gnu Tesselated Surfaces</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>obj</td>
<td>Wave Front OBJ</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>3ds</td>
<td>Autodesk 3D Modeling Format</td>
<td>✔</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAD format</td>
<td>Description</td>
<td>Import</td>
<td>Export</td>
<td>About:</td>
<td></td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
<td>--------</td>
<td>--------</td>
<td>--------</td>
<td></td>
</tr>
<tr>
<td>vrml, wrl</td>
<td>Virtual Reality Modeling Language</td>
<td>✓</td>
<td>✓</td>
<td>With the netfabb CAD Import function you can convert original CAD data directly in netfabb Professional into 3D mesh files without expensive additional software tools.</td>
<td></td>
</tr>
<tr>
<td>iges, igs</td>
<td>Initial Graphics Exchange Specification</td>
<td>✓</td>
<td></td>
<td>If any conversion errors occur during translation, they can be fixed by the highly advanced automatic repair function in netfabb Professional with just one click.</td>
<td></td>
</tr>
<tr>
<td>step, stp</td>
<td>Standard for the Exchange of Product Model Data</td>
<td>✓</td>
<td></td>
<td>Afterwards you can check printability, correct possible imperfections and start the production process without disturbing engineers or customers concerning file conversion</td>
<td></td>
</tr>
<tr>
<td>Ifc</td>
<td>Industry Foundation Classes</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jt</td>
<td>Jupiter File Format</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autodesk (ipt, iam)</td>
<td>Autodesk Inventor</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model, session, dlv, exp, catpart, cat-product, catshape, cgr, 3dxml</td>
<td>CATIA V4, V5, V6</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>asm, neu, prt, xas, xpr</td>
<td>Creo Parametric / ProE</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>x_b, x_t, xmt, xmt_txt</td>
<td>Parasolid</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>prc, prt, mfl, arc, unv, pkg</td>
<td>NX</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>asm, par, pwd, psm</td>
<td>Solidedge</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>sldasm, sldprt</td>
<td>Solidworks</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2.6 All Shortkeys (partially in netfabb Private/Pro only)

netfabb can be controlled with shortkeys. Some keys are assigned to different actions in the different modes. See the following table for an overview...

... in the default mode

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highlight part</td>
<td>H</td>
<td>Hide selected parts</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Q</td>
<td>New project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Zoom out</td>
<td>A</td>
<td>Open file dialog</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Action</td>
<td>Keys</td>
<td>Action</td>
<td>Keys</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>----------</td>
<td>----------------------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Zoom mode (zoom by rectangle)</td>
<td>F2</td>
<td>Next standard</td>
<td>SPACE</td>
</tr>
<tr>
<td>Select mode</td>
<td>F3</td>
<td>Invert Selection</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Select all parts</td>
<td>Ctrl+A</td>
<td>Show edges</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Show back faces (mark wrong oriented triangles red)</td>
<td>Ctrl+B</td>
<td>Show triangle mesh</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Show platform</td>
<td>Ctrl+P</td>
<td>Previous orientation</td>
<td>Shift+SPACE</td>
</tr>
<tr>
<td>Align tool</td>
<td>F7</td>
<td>Move + along x-axis</td>
<td>Shift+RIGHT</td>
</tr>
<tr>
<td>Highlight platform</td>
<td>P</td>
<td>Move - along x-axis</td>
<td>Shift+LEFT</td>
</tr>
<tr>
<td>Screenshot of viewing screen</td>
<td>Ctrl+C</td>
<td>Move + along y-axis</td>
<td>Shift+UP</td>
</tr>
<tr>
<td>Platform info dialog</td>
<td>F5</td>
<td>Move - along y-axis</td>
<td>Shift+DOWN</td>
</tr>
<tr>
<td>Collision control (2,5mm)</td>
<td>Ctrl+K</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move part dialog</td>
<td>Ctrl+Shift+M</td>
<td>Move + along z-axis</td>
<td>Shift+PRIOR</td>
</tr>
<tr>
<td>Rotate part dialog</td>
<td>Ctrl+Shift+R</td>
<td>Move - along z-axis</td>
<td>Shift+NEXT</td>
</tr>
<tr>
<td>Scale part</td>
<td>Ctrl+Shift+S</td>
<td>Move right</td>
<td>RIGHT</td>
</tr>
<tr>
<td>Triangle Reduction mode</td>
<td>Ctrl+T</td>
<td>Move left</td>
<td>LEFT</td>
</tr>
<tr>
<td>Toggle color &amp; texture display</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td><strong>Keys</strong></td>
<td><strong>Action</strong></td>
<td><strong>Keys</strong></td>
</tr>
<tr>
<td>Undo</td>
<td>Ctrl+Z</td>
<td>Move up</td>
<td>UP</td>
</tr>
<tr>
<td>Redo</td>
<td>Ctrl+Y</td>
<td>Move down</td>
<td>DOWN</td>
</tr>
<tr>
<td>Duplicate part dialog</td>
<td>Ctrl+X</td>
<td>Move back</td>
<td>PRIOR</td>
</tr>
<tr>
<td>Show/Hide Context area</td>
<td>F10</td>
<td>Move front</td>
<td>NEXT</td>
</tr>
<tr>
<td>Arrange Part (by outbox) dialog</td>
<td>Ctrl+Q</td>
<td>Move part to platform</td>
<td>Ctrl+DOWN</td>
</tr>
<tr>
<td>Rotate along axis (clockwise)</td>
<td>X/Y/Z</td>
<td>Delete part / slice / test / measurement / labeling</td>
<td>DELETE</td>
</tr>
<tr>
<td>Rotate along axis (counterwise)</td>
<td>Shift+X/Y/Z</td>
<td>Save Project</td>
<td>Ctrl+S</td>
</tr>
</tbody>
</table>

... in the **repair** mode

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select triangle</td>
<td>F5</td>
<td>Repair selected faces</td>
<td>F5</td>
</tr>
<tr>
<td>Select surface</td>
<td>F6</td>
<td>Repair selected surfaces</td>
<td>F6</td>
</tr>
<tr>
<td>Select shell</td>
<td>F7</td>
<td>Repair selected shells</td>
<td>F7</td>
</tr>
<tr>
<td>Clear selection</td>
<td>F8</td>
<td>Delete selection</td>
<td>DELETE</td>
</tr>
<tr>
<td>Expand selection</td>
<td>+</td>
<td>Shrink selection</td>
<td>-</td>
</tr>
</tbody>
</table>
Hide triangles  I  Show hidden triangles  V  
Show triangle mesh  G  

... in the **color / texture** mode

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paint triangles</td>
<td>F5</td>
<td>Paint Shells</td>
<td>F7</td>
</tr>
<tr>
<td>Paint surfaces</td>
<td>F6</td>
<td>Texture Pipette</td>
<td>F8</td>
</tr>
</tbody>
</table>

... in the **support** Add-on (polyline and volume only in Enhanced module)

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Action</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selection mode</td>
<td>F3</td>
<td>Remove anchor</td>
<td>F8</td>
</tr>
<tr>
<td>Select bar</td>
<td>F4</td>
<td>Show next entity</td>
<td>N</td>
</tr>
<tr>
<td>Select polyline</td>
<td>F5</td>
<td>Show previous entity</td>
<td>B</td>
</tr>
<tr>
<td>Select volume</td>
<td>F6</td>
<td>Highlight entity</td>
<td>H</td>
</tr>
<tr>
<td>Add anchor</td>
<td>F7</td>
<td>Highlight temporarily</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Show/Hide Anchors</td>
<td>Ctrl+W</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can also customize all shortkeys to your preferred extent. Go to **settings** in the toolbar and scroll down to **Short Cuts**. In order to change one of the shortkeys you just need to click on the old command and enter your new key binding. Afterwards press save to confirm your choice. It is also possible to reset the changes to default be using the **reset button**.
Figure 2.14: Click on the shortcut you are willing to change and press the new key. Afterwards save your settings or use reset to return to default.

3 Project Management

There are several methods to manage netfabb projects, read and open files and save or export projects and parts. To save processing time, STL files with a great complexity can be split before adding them to a project. For further processing, projects can be saved as netfabb project files and parts can be exported into three-dimensional or two-and-a-half-dimensional file formats. Screenshots can be exported and saved for illustration purposes. This chapter explains those functions in detail. Most of them are available in the project menu (figure 3.1).

Figure 3.1: The Project Menu
3.1 Start Project

New

With this function in the Project menu, a new project without any content is created. New files or objects can be inserted. Warning: Any changes made on previously opened projects are discarded.

Undo/Redo

The Undo function in the Edit menu reverts the last operation on parts in the default module. Only simple actions such as moving parts or starting new modules can be undone. If an operation has replaced the original part (such as cutting or a repair), it cannot be retrieved and the operation cannot be undone. With Redo, you can perform the process you have undone again.

3.2 Open Files

3.2.1 Open

This function is available in the Project menu, in the toolbar or by double-clicking on the "Open" icon in the project tree. You can open netfabb project files, STL files and other three-dimensional files created with CAD software or slice files previously saved in netfabb. The objects defined by those files are added to the project. If you open a netfabb project file, the project is loaded and the previous project is discarded. In a file browser, you can select the file you want to open (figure 3.2). Alternatively, files can simply be opened by drag & drop, if you pull files from your Explorer into the netfabb window.

3.2.2 Add Part

With this feature, three-dimensional parts saved as STL files or in other file formats can be added to the project. It can be accessed in the Part menu, in the context menu of any element in "Parts" section of the project tree or in the context menu of the viewing screen, if you do not click on a part, but on empty space. By clicking on a file and clicking the "Open" button in the appearing dialog, parts are inserted into the project (figure 3.3).
Figure 3.2: In this file browser dialog, search for the file you want open.

Figure 3.3: Browse for parts in the dialog box and add them to your project.

Advanced File Import

The **Advanced File Import** can be activated in the settings (see chapter 10). It enables you to create copies, scale the parts, and stitch the parts or to change their level of detail before you add them to your netfabb project.
Whenever you add any parts in a file format representing parts with triangle meshes, an import dialog is opened (figure 3.4). In that dialog there is a table with all parts you are about to add to the project. For every part, you can see information on the parts and your chosen options for the import: Quantity, part name, outbox size and part volume, number of triangles and shells, part quality, level of detail and scaling factor.

You can change settings for the import either for single parts in a context menu, or for all parts with the options below the table.

![Figure 3.4: The dialog for the Advanced File Import.](image)

**Change options for single parts**

If you right-click on a part in the table, a context menu is opened with which you can edit your import settings for that particular part (figure 3.5).

With the **quantity**, you can set how many copies of this part are inserted. If you have more than one, a number will be added as suffix to the part name, for example "Box_01" and "Box_02". The quantity can also be changed after a double-click on the part name. With the next option, you can **rename** your parts.

The **level of detail** changes only the display of parts and does not have any influence on the part attributes. It is conforming to the function "Level of detail" for existing parts in the
viewing options (chapter 4.3). If you change the level of detail during the import already, you can save computing time, as complex parts do not have to be rendered in full detail from the start.

![Figure 3.5: The context menu after a right-click on a part in the import dialog.](image)

To set the scale of parts, you can either perform the functions **inches to mm** or **mm to inches** before opening the parts (see chapter 6.2.3), enter a custom **scaling factor** or set back the scaling to the usual part size (100%). You can find these options in a submenu.

If you **Stitch**, open triangle edges are stitched together immediately, as with the function "Stitch Triangles" in the repair module (chapter 7.5.2). This may or may not repair the part, but will almost always improve the part quality. When triangle edges are stitched, you can see instant changes in the number of triangles and shells and in the part quality. If parts are damaged, there is a warning sign in the column for the part quality (the same as for damaged parts in the project). If they are good, there is a green check. You can also run one of the standard or a custom repair script right at the file import. This way you can make sure, that parts are always repaired before printing.

If you click on **Remove** in the context menu, the part will no longer appear on the list and will not be added to the project.

**Settings for all parts**

Below the list of parts, you can edit settings which apply for all parts. For the **positioning of the parts**, you can choose one of three options in a dropdown menu:

- **According to file data**: All parts are positioned exactly as defined in the file. Most three-dimensional files contain positional information.
- **Move parts to origin**: All parts are moved to the origin. The lowest outbox coordinates will be X=0, Y=0, Z=0
• **Arrange parts:** All parts are arranged next together in the platform, with their outbox as reference. The first part is inserted at the origin.

If the box **Stitch all** is ticked, the triangles of every part are stitched when you add the parts.

The **General level of detail** sets the level of detail for all parts. Choose a value in the dropdown menu. If you tick the box **Set LOD (level of detail) as default,** your level of detail value will become standard for the Advanced File Import.

The option **Move stitched parts into group** generates a group in your project into which all added parts which have been stitched are moved. Parts that are not damaged or cannot be stitched at all, but are stitched nevertheless (for example with the option "Stitch all") are not moved into this group.

In the bottom left there is the option **Always use this dialog.** If you deactivate this, the advanced file import will no longer appear when you add parts. You can reactivate it in the settings.

If you increase the quantity of the single parts to more than 5, you can let the parts be organized in groups. For example, you open a part and want to load it 12 times, change the **Automatic grouping of parts** to more than 10 duplicates. All 12 parts will then be organized in 1 group in the project tree.

### 3.2.3 File Preview Browser

The File Preview Browser is available in the Project menu and opens a browser window in the tabsheet, where it is possible to search for and open files. If you click on a file name, a preview of the object is displayed on the viewing screen without it being added to your project. You can also scroll through files with your cursor buttons.

The preview can be obtained for both three-dimensional files and two-and-a-half-dimensional slice files with various file formats. Clicking on "Open" or double-clicking on the file name inserts the selected file into your project. That way, the file preview browser allows a quick browsing of databases without necessarily opening each part to
look at it (Figure 3.6, Figure 3.7). Viewing options such as zooming in and changing perspectives are available as in an open project.

![Image of File Preview Browser](image1)

**Figure 3.6:** The File Preview Browser offers a preview of files without adding them to the project. Here, an STL file is viewed.

![Image of Slice File Preview](image2)

**Figure 3.7:** A preview of a slice file, zoomed in.

### 3.2.4 Create Report Sheets (partially in netfabb Private/Pro only)

The report creation feature is available in the Project Menu. netfabb helps you with making official documents and quotations containing information about the models or
the whole platform. You need two extra installations on your computer to view these reports:

- Java 1.8.0_25 or higher
- Pentaho Runtime (included in the extended / complete installer of netfabb or can be installed afterwards when netfabb asks you for this in the report dialog.)

When you have done measurements on your part, you can also export this view including the measurements into the reports. Simple stay in (or go back via the project tree into) the measure mode and open the reports from there.

Once the report is created, you can see screenshots of the part and data according to the form you chose (Figure 3.8). You can use these documents as templates and hand them out to your customers or co-workers to tidy up your workflow. With Create Report in the Project Menu, you get a dialog where you can choose one of the reports (Figure 3.9). After you have opened the document, you can simply print or edit it to a quote and add notes.

![Image of report selection dialog]

Figure 3.8: Choose a report: A document/template with important information for manufacturing or quoting the parts will be created.
Customization of report templates

You can also customize these reports and create your own template. Therefore, you need the very easy to use Pentaho Report Designer, which can be downloaded here: [http://community.pentaho.com/projects/reporting/](http://community.pentaho.com/projects/reporting/).

In Pentaho, you can either

- create a “new report” by yourself,
- let the software help creating a new report with the “Report Wizard”
- or copy an existing one that comes close to your needs and edit it (recommended):

This is a short description of how to do that (there’s also a detailed manual included in the Pentaho software).

- Make sure the free software Pentaho Report Designer is installed on your computer (see link above). This program uses the file format *.prpt.
Figure 3.10: The Pentaho Report Designer for creating own templates. Either create your own new report, use the wizard, or copy an existing template and edit it.

- The predefined templates can be found in the netfabb installation folder in Reports (e.g. in Windows usually in `c:\programs\netfabb Professional\reports`)
- In the layout of templates you usually find text-, image- and parameter fields. Each of those can be copied and edited. To do so, simply double click on the field and type in a new text or parameter. A detailed list of all available parameters and pictures for screenshots can be found in this manual’s appendix.
Figure 3.11: The template "Simple Part Overview" can be copied in the Explorer and edited in Pentaho. Text-, image- and parameter fields are then easy to adjust and place. Use the appendix at the end of this manual for a list of all available parameters.

- For all detailed field information, take a look at the Style tab and the Attributes tab on the right.
- Further information about how to edit the templates can be found in the Pentaho manual.
- Save the completed report template as a .prpt file and save it in the “reports” folder of netfabb. With the next start of netfabb, your new template will appear automatically.

3.3 Save and Export

3.3.1 Save

If you choose Save in the Project menu, the project is saved and its previously saved version is overwritten.
If you choose **Save As** or if there is no existing version of the project, a dialog window is opened, in which target directory, file name and file type can be chosen (Figure 3.12).

![Save file as dialog](image)

**Figure 3.12: Choose target directory and file type and insert file name in the browser dialog.**

### 3.3.2 Export Part

The option **Export** can be found in the Part menu or in the context menu after right-clicking on a part in the screen or in the tree. It saves selected parts in either a 3D triangle mesh or slice file format. The new files are then saved in a selected directory.

First, select all parts you want to export. When you move the mouse to **Export**, a submenu opens where you can either choose a triangle mesh format or slice files in general. If you export more than one part, you will be able to change the format again in the Export dialog box. For exporting a part into a three-dimensional file, the same file types are available as for opening files (chapter 2.5), plus the AMF and the VRML format.
If you export a part as slice, a slice file is created without the intermediate step of viewing and checking it in the Slice Commander. The options for directly exporting slice files are the same as for exporting slices.

**Export Parts to triangle mesh formats**

After clicking on a format, a dialog box opens for altering your export options (Figure 3.13). In the field **Parts**, the number of selected parts is given. Next, you can change the **format** of the target files in a dropdown menu. You will get different export options for the different file formats (Figure 3.14).

For the **output type**, you can choose if you want to save all selected parts in one file or save all parts in different files. For different files, choose if you want to give them a **common file name with numbers**, a **common file name with part ID** (the part number in the project, see chapter 5.6), save them with their **original part names in the project and a loading list**, or create file names with a **common file name and the original part name**. With the option "Original file name with loading list", an additional XML File is saved which contains a list of all exported files. If you open that XML file with netfabb, all files in the list are opened at once. The common name for all other options can be entered in the next text field. Click on the button "..." to edit the target folder. In the field **Example**, you can see a preview to how your files will be named.

At the bottom of the dialog, there is a tabsheet with the two registers **File quality** and **Outbox**.
Figure 3.13: The dialog box for exporting parts as STL files.

Figure 3.14: The dropdown menu for the export format.
In the register **File quality** (Figure 3.16), you can use the button **Check** to see if the files you are about to create may cause errors when they are opened again. You can tick a box at the bottom of the dialog to **always check file quality** when the export dialog is started. After checking, the number of degenerated faces and manifold edges is specified in the text fields. Degenerated faces are very tiny or thin triangles and can result in little holes. Manifold edges are several triangle edges at the same coordinates and may be split open. The **tolerance** value you can enter below determines the precision with which errors are calculated. If the distance between two triangle corner points is below the entered value, they are interpreted as one point and will be reported.

If there are any problems, a red X is displayed on the right. If the files are error free, a green tick is displayed. With the button **Optimize** you can fix the errors automatically. The files are rechecked and should become good. Sometimes, you have to repeat the repair.

In the register **Outbox**, the dimensions of all selected parts are given. First, you get the length of the outbox along all three axes, then the minimum and maximum values along the axes.
Figure 3.16: Top: The file quality has not yet been checked. Center: The exported files have degenerated faces and manifold edges. Bottom: After clicking on "Optimize", the files are error-free.

3.4 Autodesk Spark (beta)

Spark is Autodesk’s platform for connecting additive manufacturing. Please note that the integration is currently still in beta status and can only be used with netfabb for storing files. Spark can be accessed at https://spark.autodesk.com/.

To connect your netfabb to Spark open netfabb and go to project ➔ Autodesk Spark (beta). Your default browser will open and forward you to the spark login page (Figure 3.17).
Figure 3.17: The spark login page. Use your existing account to log in, create a new account or log in with facebook

Create a new account, log in with existing credentials or your facebook account. After the login succeeds your netfabb is connected to Spark.

Data in Spark is grouped into Assets, where each asset can contain multiple Source Files, which are the actual 3D models. To upload a part to Spark you can use the export part dialog in netfabb and choose an existing asset or create a new one. After choosing an asset click on save file to start uploading the file to spark.
To upload a 3D model you have to create an asset first by clicking on the button. In the next dialog you need to name the asset and can also add some additional information about the asset, then click ok to create the asset. You can now upload 3D models to the asset.

Figure 3.19: Add models to the Asset, add a new Asset or delete Assets
To download a model from Spark, select **Autodesk Spark** from the project menu, then select the model and click on **Open file** to download it.

![Autodesk Spark](image)

*Figure 3.20: Example for an Asset filled with different models*

After setting up Spark you can also use the symbol in the iconbar to import files directly from Spark.

### 3.5 Prints and Screenshots

**Print**

This function in the Project menu directly prints the current view of the project. With "Configure Printer", you can edit the settings for the printer.

**Screenshot to Clipboard**

This feature is available in the Edit menu and copies a screenshot of the viewing screen into the clipboard. The screenshot then can be inserted into other files.

**Save Screenshot**

With this function in the Edit menu, a screenshot of the viewing screen is saved as PNG file in any chosen directory.
4 Viewing Options

The view to a project in the viewing screen can be altered in many ways. The perspective from which objects are seen can be set to seven different standard directions or can be intuitively rotated by use of the mouse. To shift the view on the displayed project or to zoom in and out, you can also use the mouse very easily, or use one of several standard zoom options.

![Figure 4.1: The View menu](image)

Furthermore, it is even possible to hide objects, which makes it easier to keep a clear overview of the project.

To have an unhindered view on chosen parts without removing any others, you can also hold the 'h'-key to **highlight selected objects**, which will be displayed in the foreground, regardless of their position.

Further options for viewing the screen include the level of details, highlighting back faces, displaying the triangle mesh of any chosen part, edges on parts and the platform.
4.1 Perspectives

The perspective refers to the direction from which a project is viewed. In the bottom left of the viewing screen is a coordinate system indicating the current viewing perspective (Figure 4.2).

![Figure 4.2: Three Different Perspectives with the Coordinate System](image)

To change the perspective, there are two ways. First, by holding the right mouse button and moving the mouse in the direction you want to turn the project visually, the perspective can be intuitively rotated to any position, with the center of the screen as center of rotation. If you right-click close to the edge of the screen, the perspective is only changed two-dimensionally to the left, right, up and down.

If you want a certain point on a part as center of rotation, right-click on this point and click on "Center View Here" in the context menu. Your view will be shifted and the point you clicked on moved into the center, subsequently becoming the center of rotation.

Second, there are seven standard perspectives. The perspectives from the top, bottom, left, right, front and back refer to the coordinate system, whereas the front is the X-Z-plane. The isometric view is a view from the front-left-top-corner of the platform. That way, you gain a kind of three-dimensional view on the project and on objects which are aligned along the axes (Figure 4.3).
There are three ways to switch between those standard perspectives:

- They can be selected with one mouse click on the respective icon in the toolbar or by selecting one of the perspectives in the View menu.
- The colored planes in the coordinate system are further shortcuts to the standard perspectives. With default color settings, by clicking on the grey space in the center, the perspective shifts to the isometric view. Clicking on the blue space switches between the views along the Z-axis (top and bottom), the red space switches between views along the X-axis (left and right) and the green space switches between views along the Y-axis (front and back).
- You can also switch forwards between them with your Space key or switch backwards with Shift and Space. If you have not yet set a standard perspective, the first is the isometric perspective.
4.2 Centering and Zooming

Shift View
By holding the central mouse button and moving the mouse, the view on a project can be shifted to the right, left, up or down. This changes only the center of the main screen without changing the perspective. If you do not have a central mouse button, hold Shift and use the right mouse button.

Center View
When you right-click on a part in the screen, the option Center View Here is available in the context menu to shift the view. The point you clicked on is then moved into the center of the viewing screen. The option is also available in the View menu. After selecting the option there, left-click on the point you want to move into the center.

Zoom
The scroll button of the mouse can be used to zoom in and out. If you roll forward, you zoom in and if you roll backwards, you zoom out. If you do not have a scroll button, hold both Ctrl and the right mouse button and move the mouse up and down. With the keyboard, you can zoom in with Q and zoom out with A.
Additionally, there are several default options to center and zoom. Depending on which function you choose, netfabb moves certain components into the center and resets the zoom so that these components fit exactly into the screen. These options are available by clicking on the respective icons in the toolbar or in the View menu.

Figure 4.4: The Zoom Options in the toolbar

Zoom to Parts
The parts of the project will fit exactly into the screen.
**Zoom to Selected Parts**

The screen will include all selected parts.

**Zoom to Platform**

netfabb calculates a frame for the viewing screen which contains the platform.

**Zoom to All**

The View will include all parts and the whole platform.

**Zoom to Selected Area**

This activates a different mode and is also available by pressing F2. It enables you to choose a selection by holding the left mouse button and dragging a selection rectangle. netfabb then zooms in to that selection (Figure 4.5). In turn, you do not select parts by clicking on them and cannot move or rotate parts by *drag & drop*. You get back to the normal mode by pressing F3 or clicking on the respective icon in the toolbar (with the mouse cursor depicted on it).

![Figure 4.5: Left: A selection rectangle is dragged. Right: netfabb zooms in to that area.](image-url)
4.3 Displaying Options

Hide and Show Parts

Selected objects can be hidden or shown by choosing the respective option in the context menu or by clicking on the orange eye next to the objects name in the project tree (Figure 4.6). When an object is hidden, this orange eye turns grey. Hiding objects that do not need attention for the moment can be helpful to keep a clear overview on the project. In the tabsheet, there is a small info box specifying how many parts in the project are hidden.

Figure 4.6: Click on the eye to hide a part.

To prevent an obstructed view to parts in the background, marked parts can also be highlighted and displayed in the foreground by holding the ‘h’-key.

In the context menu of the viewing screen and of parts in the project tree or in the View menu, several additional options are available for showing and hiding parts:

If you right-click on empty space in the screen, you can either show all parts, hide all parts, invert the visibility of all parts or hide unselected parts (so only your selected parts are displayed). If you right-click on a part in the screen or in the project tree, you can either show or hide only your selected parts (or "hide unselected parts" as well). As the selection may change with the right-click, it can be necessary to access this function in the project tree or in the View menu. In the screen, it makes only sense, if at least one part of your selection is shown already and you click on that part.

Level of Detail

The level of detail of the displayed project can be changed either in the View menu or in the toolbar. You can choose from several levels between 0.1% and 100%. These levels are implemented for all selected parts or, if no parts are selected, for all parts (Figure 4.7). In the project tree, the current level of detail is specified in brackets after the part name.
The simplified presentation is especially recommended for projects containing very much or very complex parts. With a low level of detail the program will be much quicker whenever the view is changed in any way, because parts are no longer displayed in every detail.

Despite the simplified presentation, the actual attributes of the parts remain unchanged.

**Highlight Back faces**

The interior side of triangles is always marked red, even if the part is selected. It helps you to detect inverted triangles, holes and cuts in the standard module (Figure 4.8). You can activate and deactivate that option in the View menu.

**Show Edges**

This option in the View menu determines, if sharp edges on objects are emphasized with black lines (Figure 4.9).
Show Platform
The platform is the printable area of the project. It can be shown or hidden in the View menu.
If one or more parts are selected and you can hold the 'P'-key to display a virtual platform with the same origin coordinates as the selected part (Figure 4.10). That way you can estimate how much space your selected parts will occupy in the platform if you move them to the origin.

Show part names
If you have loaded many parts, you can get a better overview when you let netfabb show the part names in the viewing screen. Activate it in the View menu or with pressing Ctrl + L. It will additionally display the outbox measurements on the selected part.
Show Triangle Mesh

This option activates or deactivates the visualization of the triangle mesh of a part (Figure 4.12). It can be found in the context menu after right-clicking on the respective part in the main screen or in the project tree.

Figure 4.12: Hide or show the triangle mesh.

5 Part Management

The part management for netfabb includes the creation of primitive parts, the duplication of parts, part attributes, positioning and scaling, a platform overview and collision detection. For managing and editing parts, they must be selected first.
5.1 Add and Remove Parts

Saved parts can be added to the project either with the function Add Part (chapter 3.2.2) or with the File Preview Browser (chapter 3.2.3). You can also add parts by drag & drop, if you pull them from your windows folder into your netfabb window.

A selected part in the project can also be removed and deleted from the current project. This function can be accessed via the Part menu, in the context menu after right-clicking on the part to be removed, by double-clicking on the red X-icon next to the part in the project tree or by pressing the Delete key on the keyboard after selecting the part.

5.2 Select Parts

For any kind of viewing, handling or processing operation in netfabb, it is essential to first select the part you want to edit. Parts can be selected by simply clicking on them in the main screen or in the project tree. Selected parts are always colored green, framed by green brackets and marked in the project tree. In the tabsheet, below the cutting functions, information is given regarding the size, volume, area and number of triangles of the selected part. Below, you can see how many parts are selected and how many parts are in the project in total (Figure 5.1)

![Figure 5.1: Information about selected parts is given in the tabsheet.](image)

You can select as many parts as you like. If you hold Shift, parts are added to the selection by clicking on them. By holding Ctrl, parts can be both added to or removed from the selection by clicking on them. If you select parts in the project tree, the Shift key works differently, as holding Shift and clicking on a part selects all parts in the list...
between the part clicked on and the last part selected without Shift. By holding the left mouse button and dragging a selection rectangle with the mouse, you can select everything within that frame (Figure 5.2).

**Figure 5.2: Select several parts at once with help of a selection rectangle.**

In the context menu of the viewing screen, if you do not right-click on a part, but on empty space, you can either select all parts, select no part to clear the selection, or invert the selection. With that last option, selected parts are deselected and unselected parts are simultaneously selected (Figure 5.3). All three options are also available in the Edit menu.
Figure 5.3: Left: If you right-click on empty space in the screen, the context menu offers general options for your selection. Right: The inverted selection of figure 5.2.

Additionally, as a shortkey, you can press Ctrl+A to select all part in the project tree. If two or more parts are selected, the information in the tabsheet is then based on all selected parts. Many, though not all, handling operations are conducted with all selected parts.

5.3 Standard models - the part library (partially in netfabb Private/Pro only)

Standard models are simple three-dimensional objects that can be created with a few clicks in netfabb. After clicking on the Part library icon in the toolbar or choosing the respective option in the Edit menu, the user can choose from a list of simple three-dimensional objects that can be selected with a double-click and inserted into the project (Figure 5.4). Although their basic geometry is already given, there are many parameters that can be specified in detail by the user.
That way, you can create a variety of parts. The settings can be saved as default setting for the primitive part by clicking on the button below. The button "Load Default" restores the default settings after the parameters have been changed. By clicking on **Apply**, the part is inserted into the project. In the following list, you can find a short description of each parameter:

![Netfabb interface showing primitive selection](image)

**Figure 5.4: Choose a primitive in the main screen.**

<table>
<thead>
<tr>
<th>Term</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Caption</td>
<td>Type in the actual text (text primitive) or label your part (mold, whistle)</td>
</tr>
<tr>
<td>Clearance to screw</td>
<td>define a distance between the threads of screw and nut</td>
</tr>
<tr>
<td>Color</td>
<td>Determines the color appearance in netfabb (only display in the software, not in reality)</td>
</tr>
<tr>
<td>Count holes (in X-/Y-Direction)</td>
<td>number of holes in each direction</td>
</tr>
<tr>
<td>Depth</td>
<td>measures of part in z-axis</td>
</tr>
<tr>
<td>Design</td>
<td>choose a round, oval or rectangular shape for the mold</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td>Direction</td>
<td>models facing up- or downwards</td>
</tr>
<tr>
<td>Edges</td>
<td>number of edges the surface has</td>
</tr>
<tr>
<td>File</td>
<td>click here to browse for a file</td>
</tr>
<tr>
<td>Fit</td>
<td>choose if the bracelet should be loose, closed or balanced around your wrist</td>
</tr>
<tr>
<td>Font</td>
<td>determine the font, size and effects</td>
</tr>
<tr>
<td>Good Triangles</td>
<td>good triangles have no acute angles (there is no angle below 90°)</td>
</tr>
<tr>
<td>Handles</td>
<td>add any number of handles to your vase</td>
</tr>
<tr>
<td>Height</td>
<td>measures of part in z-axis</td>
</tr>
<tr>
<td>Height partitions</td>
<td>divides the triangles in the z-axis by this certain number</td>
</tr>
<tr>
<td>Horizontal mesh density</td>
<td>changes the resolution of the bracelet. the higher the number, the higher the resolution</td>
</tr>
<tr>
<td>Invert Colors</td>
<td>concerns Bitmaps and Height maps: Usually all dark colors are being filled/raised. With &quot;Invert Colors&quot; it’ll be the other way round and only all bright colors will be filled/raised</td>
</tr>
<tr>
<td>Keep aspect ratio</td>
<td>With a &quot;no&quot;, measures in x-axis and y-axis can be changed independently.</td>
</tr>
<tr>
<td>Kind of head</td>
<td>available are hexagon socket, hexagon head and slotted</td>
</tr>
<tr>
<td>Lead length</td>
<td>length in z-axis, until one rotation of helix is finished</td>
</tr>
<tr>
<td>Length</td>
<td>measure of part in x-axis</td>
</tr>
<tr>
<td>Level of detail</td>
<td>resolution of part in Bitmaps and High maps</td>
</tr>
<tr>
<td>Level of grey</td>
<td>determines how many colors are detected in Bitmaps and height maps (up to 250 are possible)</td>
</tr>
<tr>
<td>Metric thread</td>
<td>Diameter of the screw’s thread (uses standardized parameters)</td>
</tr>
<tr>
<td>Name</td>
<td>This name will appear in the project tree. Nominal diameter Diameter of the screw’s thread (uses standardized parameters)</td>
</tr>
<tr>
<td>Number of gears / teeth</td>
<td>number of rotations in Helix / number of teeth in gear wheel</td>
</tr>
<tr>
<td>Pitch</td>
<td>determines the angle of a lead in the helix</td>
</tr>
<tr>
<td>Profile rotation angle</td>
<td>defines how the surface is aligned</td>
</tr>
<tr>
<td>Radical edges</td>
<td>changes the resolution of the vase. the higher the number, the higher the resolution</td>
</tr>
<tr>
<td>Radius</td>
<td>Changes the radius/size of parts</td>
</tr>
<tr>
<td>Resolution</td>
<td>defines the resolution of the part’s surface. the higher the number, the higher the resolution</td>
</tr>
<tr>
<td>Rotation Angle</td>
<td>angle of bending (in Rotation Hyperboloid)</td>
</tr>
<tr>
<td>Smooth triangles</td>
<td>edges of model will be less sharp</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Spin</td>
<td>Rotates the picture sweep from start to end by a specific angle</td>
</tr>
<tr>
<td>Steps</td>
<td>Changes the resolution of the picture sweep. The higher the number, the higher the resolution</td>
</tr>
<tr>
<td>Style</td>
<td>Choose from three different shapes in the bracelet primitive</td>
</tr>
<tr>
<td>Surface</td>
<td>Type in desired size of surface, other measures will be adjusted</td>
</tr>
<tr>
<td>Tangential edges</td>
<td>Changes the resolution of the vase. The higher the number, the higher the resolution</td>
</tr>
<tr>
<td>Thickness of bars</td>
<td>Width of each bar between two holes (in cylinder with hexagon grid)</td>
</tr>
<tr>
<td>Thread Length</td>
<td>Length of the thread only, without head</td>
</tr>
<tr>
<td>Tolerance</td>
<td>A higher tolerance makes the roundness of parts less accurate and results in a lower number of triangles.</td>
</tr>
<tr>
<td>Triangle Edge Length</td>
<td>Max. length of triangles edges</td>
</tr>
<tr>
<td>Triangles</td>
<td>Number of triangles</td>
</tr>
<tr>
<td>Turns</td>
<td>Determines how many turns you need in your helix</td>
</tr>
<tr>
<td>Type</td>
<td>Choose between predefined models</td>
</tr>
<tr>
<td>Vertical mesh density</td>
<td>Changes the resolution of the bracelet. The higher the number, the higher the resolution</td>
</tr>
<tr>
<td>Volume</td>
<td>Type in desired volume, other measures will be adjusted</td>
</tr>
<tr>
<td>Wall thickness</td>
<td>Distance between inner and outer shell</td>
</tr>
<tr>
<td>Width</td>
<td>Measures of part in y-axis</td>
</tr>
<tr>
<td>Wrench size</td>
<td>Distance between two opposite edges of the outer nut contour</td>
</tr>
<tr>
<td>Wrist circumference</td>
<td>Determines the inner circumference of the bracelet</td>
</tr>
</tbody>
</table>

### 5.4 Duplicate Parts

This feature can be accessed via the Part menu or in the context menu after right-clicking on the respective part and creates a chosen number of exact copies of the selected part. In a dialog box, you can set the overall number of copies. So, if you want to create one duplicate, you have to set the counter to two copies.

Below, there is a little box **Arrange Parts**. If it is not ticked, the duplicates will be placed in the same place as the original part. If it is ticked, you can place the duplicated
parts at specified positions next to the original part. Therefore, you can change the number and the distance of duplicates in each direction (Figure 5.5).
To define how many duplicates shall be arranged next to the original, you insert the **number of copies along all three axes**. As this includes the original, the minimum value is always one (even if you manually insert zero or a negative value, the count will be one). The number of copies along the three axes is always adjusted when you change the total count of copies.

If the box **auto-adjust total count** is not ticked and you change the number of copies along one axis, the count of duplicates along the other axes is adjusted automatically so that the number of total copies stays the same. If the box to the left of an axis is unticked, the count along this axis will not be adjusted.

If the box "auto-adjust total count" is ticked and you change the number of copies along one axis, the total count is automatically adjusted instead of the count along the other axes.

Next, you can edit the **distance of arranged copies** along the three axes. The value you enter always refers to the outbox of the parts. If you insert zero, the lowest coordinate value of the second part will the same as the highest of the original/previous part. If you increase
the value, the distance becomes bigger, while with negative values, the parts may overlap. The standard value is 2mm.
The total expected size of all duplicates is calculated in the bottom third of the dialog. If you have selected more than one part, the whole arrangement of selected parts is treated as if it was one part.

5.5 Position and Scale
You can move, rotate or scale parts easily by the mouse or by giving netfabb specific coordinates, angles and scaling factors.

5.5.1 Move Parts
Parts in a project can easily be moved with the mouse by *drag & drop*, left-clicking on the green square of a selected part and moving the mouse. If more than one part is selected, they are all moved together.

For finer adjustment, selected parts can also be moved up, down, left and right with the arrow keys and backwards and forwards with the Page Up and Page Down keys. Normally, this movement is conducted in relation to the current perspective. If you hold Shift, the Left and Right keys move the part along the X-axis, Up and Down move it along Y-axis and Page Up and Page Down move it along the Z-axis. Alternatively, by clicking on the "Move" icon in the toolbar, choosing "Move" in the Part menu or context menu or by pressing M, the user is able to set specific coordinates in a dialog window, to which the selected parts are subsequently moved. At the top of the dialog, the current selection, the part’s position and size are specified. Below, coordinates can be inserted either as absolute position or as relative position. The absolute position is the position in relation to the coordinates X=0, Y=0, Z=0, whereas the relative position refers to the current position. If a part is moved to the origin, its’ outbox is positioned at the coordinates X=0, Y=0, Z=0. You can also move the *center* of the part to the origin or just move the part down to the platform.
If the box Keep window open is ticked, you can apply the changes by "Translate", the dialog will stay open and you immediately can move the part again.

### 5.5.2 Rotate Parts

Similarly to moving parts, they can also be rotated easily with the **mouse**. This is performed by left-clicking on the green brackets of selected parts, holding the mouse button and moving the mouse in the direction in which you want to turn the part. Thereby, the axis of rotation is normally the direction from which the part is seen, but if you hold Ctrl, the part is rotated around the closest main axis (Figure 5.7). With pressing the ALT key, the part will be rotated in 10° steps (value adjustable in the program settings). Hit the keys X, Y or Z and the part is rotated by 45° clockwise, with Shift counterclockwise (value adjustable in the program settings). This function is available in the toolbar, in the Part menu or by pressing R.
Alternatively, parts can be rotated by a **specific angle** around one of the three axes (Figure 5.8). In the "Rotate parts" dialog, you see the current selection, its position and size are shown, as well as the rotation center. Now you can either click on a standard angle (45°, 90°, 180° or 270°) or insert an angle in the empty field. Below, define the X-, Y- or Z-axis or your own free axis as axis of rotation.

If the box **Keep window open** is ticked, you can apply the changes by "Rotate", the dialog will stay open and you immediately can rotate the part again.
5.5.3 **Align Parts**

By clicking on the "Align" icon or pressing F7, the align-mode is activated. You can control the orientation of parts either to the platform or to other parts. First, choose the part you want to align, then click on the align parts icon. A new tabsheet will open up on the right. (Figure 5.10)

Then select how you want to align the part to the other part. You can:

- align parallel (both surfaces direct in the same direction)
- align antiparallel (the surfaces direct in the opposite direction)
- align perpendicular (one surface stands on the other one in a 90° angle)
- translate two points (click on one point on each part and they will be laid on top of each other)

![Image](image.png)

*Figure 5.9: First choose the part you want to align, then click on align parts. The new tabsheet offers various options for the alignment.*

Click on the surface of the selected part which should be orientated, then click on the surface it should be aligned to on the other part. In the example of the screenshots, we want to align the bottom of the screw to the leaning side of the frustum of pyramid (Figure 5.11 and Figure 5.12).
**Figure 5.10:** Example: Choose the second icon align antiparallel. After that, click on the bottom side of the screw head and then click on a leaning surface of the other part.

The single steps of your alignment are now listed in the tabsheet. A new icon has appeared:

Set the distance of the two surfaces: When you open this dialog and type in 0.0mm for example, the part will be moved parallel so that the two surfaces have a distance of 0.0mm.

**Figure 5.11:** Result: The two selected surfaces are aligned in the opposite direction.

Now you have three options to continue with the calculations:

- You can undo unwanted steps.
- You can undo all the steps at once and start again.
- Apply the changes and stay in the alignment mode to continue with further actions.

To move the two surfaces lying exactly on top of each other, choose **translate point** and click on one point on the bottom of the screw head and on one point of the regarding surface of the frustum of pyramid. The two parts will be moved closely together. Click on **apply**
and you can continue with other actions (for example the Boolean operation (see chapter Error! Reference source not found.).

When you open the alignment mode a second time, you see three more icons on the upper right corner. With those you can align the surfaces to the x-, y- and z-axis (Figure 5.12).

![Figure 5.12: Left: The part is lying leaning in the platform. Right: The part is aligned and laid down to the bottom plane.](image)

You can also disable the animation of the alignment. The part will then be placed without any delay. This can increase workflow speeds when aligning multiple parts.

When you have found the perfect alignment for your parts, click on Apply in order to get back to the default mode.

### 5.5.4 Scale Parts

By clicking on the "Scale" icon, choosing "Scale" in the Part menu or context menu or by pressing S, the dimensions of one or more selected parts can be changed. In the "Scale Parts" dialog window, the current selection, the part’s position, size and its scale center are displayed.

First, you can insert the factor, by which the length along the respective axis is multiplied (Figure 5.13). With factor 1.00, the dimension remains the same. With a factor bigger than 1.00, the part is enlarged, while with a smaller factor than 1.00, the part is shrunk. If you insert a negative value, the part is inverted. It’s also possible to scale by percentage or enter the actual desired part size.
With the "Fix scaling ratio" box ticked, the dimensions of all three axes are scaled by an equal factor and consequently makes the whole part bigger or smaller. With unequal scaling however, different factors can be entered for the three axes. Consequently, the scaling process changes the proportions of the part’s geometry and changes the part’s shape (Figure 5.14).
If the box **Keep window open** is ticked, you can apply the changes by **Scale**, the dialog will stay open and you immediately can scale the part again.

### 5.5.5 Arrange Parts (partially in netfabb Private/Pro only)

All parts in the project are arranged automatically in the platform, avoiding any collisions. The outbox is taken as reference (Figure 5.15). The function is available in the Edit or in the context menu after right-clicking on empty space in the screen.

![Figure 5.15. Left: A project with randomly scattered parts. Right: With "Arrange parts", the parts are sorted in the platform.](image)

In a dialog window, you can set the accuracy and the minimal distance between the parts (Figure 5.16). The accuracy determines the raster size for the calculation, as the software calculates a three-dimensional raster across the platform. No two parts will touch the same raster cell. The distance determines the minimum distance between the outboxes off the parts. The outbox is visualized with green brackets if the part is selected.

![Figure 5.16: The dialog box for the arranging parts.](image)
With the option **only 2D** the parts will be arranged two-dimensionally on the bottom plane of the platform. Parts which do not fit onto the bottom plane are moved out of the platform. In the next tab, you can decide whether you want to confirm or change your settings every time you recall the function with Ctrl + Q or not. Click on Arrange parts to start the calculations.

### 5.6 Part Attributes

All parts have attributes which make them easier to organize in a netfabb project, although they do not have a direct influence on their physical characteristics when produced. These are the part’s name, color, group and number.

**Rename Part**

Parts in your project can be renamed via the context menu, which is opened by a right-click on the respective part in the main screen or in the project tree, or in the Part menu. Then, you can insert a new name.

**Change Colors**

The color can be changed for parts and slices. Right-click on them and choose "Change Color" in the context menu or double-click on the colored dot next to the part in the project tree. That dot always has the current color of the part. Colors are always changed in a dialog box, which provides both predefined colors or define your own colors (see chapter 9.2).

**Groups**

Groups of objects can be created in the context menu after right-clicking on a part in the Parts section of the project tree. You can either just **create a new group** or **create a group with selected parts** (Figure 5.17). Parts can then be added to the group or moved out of the group by **drag & drop** within the project tree. This allows
you to organize and structure the project. By clicking on a group in the tree you select all parts in the group.

If you right-click on the group in the tree, a context menu appears for editing the group. You can rename groups, remove groups and all associated parts or, if you have groups which do not contain any parts, you can remove all empty groups. If you click on Ungroup, the group you clicked on is removed and the parts it contained are moved into the superordinate group or the Parts section. (Figure 5.18).

If you change the color of the group, all parts in the group and all parts you add to the group get the same color. The icon of the group in the tree is updated so that the sphere above the folder is displayed in the group color. If parts are moved out of the group, they get back their old color.

If you Show or Hide a group, all parts in the group are shown or hidden. You can also do that by clicking on the little eye next to the group in the tree. This eye also indicates, if the parts of the group are shown or hidden. Whenever all parts in the group are shown, the eye is orange. If all parts are hidden, it is grey. If some parts are shown and some hidden, it is half orange and half grey (Figure 5.18).
Part Numbers

If you right-click on the Parts section in the project tree, you can activate or deactivate the option **Show Part Numbers**. If it is active, a number is displayed next to each part in the project tree (Figure 5.19).

The first part in the project has the number 1. To each additional part, the next number is assigned, even if parts with lower numbers have already been removed. Parts also count as new parts, if they are edited, for example if they are repaired. The numbering of parts may help to keep an overview over projects containing many parts. In the same context menu, you can also **renumber all parts**. If you do so, the parts are given continuous numbers again, but still according to how long they have been in the project. So, the oldest part remaining in the project will get the number one, the second oldest the number 2, and so on.
5.7 Platform Overview

The platform overview can be obtained by pressing F5 or is available in the Edit menu or in the toolbar. It displays a window with an overview of all parts in the project, including part number (ID) status, length, width, height, volume, area, number of triangles, edges and points of the parts.

Also, the total size, volume and area of the parts and the filling degree of the platform are displayed (Figure 5.20). If the box "Selected Parts Only" at the bottom of the dialog is ticked, unselected parts are not listed.

This data can be exported and saved as a CSV file. In the bottom left of the dialog, you tick a box to export only a list of the file names without any additional information. Target directory and file name can be chosen in a browser window.

![Platform Overview](image)

*Figure 5.20: Information about the parts in the platform are provided in a dialog box.*

*They can be exported as .csv file.*

6 Part Edit
Three-dimensional parts can be edited in various ways. Features include the analysis of parts, simple part editing functions, such as mirroring, inverting and converting in size according to the length units mm an inch and the conducting of simple cuts. Furthermore, any number of parts can be merged to one part and any part consisting of more than one shell can be split into equivalent parts. Also, new shells and offsets can be created on the basis of existing objects, cutting planes can be defined freely and parts can be unified, subtracted or an intersection of parts can be created with the Boolean Operations Module. Further part editing functions are part of the repair module (chapter 7.1). These are features for which you have to work with the triangle mesh more specifically.

6.1 Part Analysis

For the analysis of a part you have five options. A standard analysis, an analysis of upskins and downskins, of the center of gravity, the wall thickness and the analysis of the part’s shadow area. For users, who have purchased netfabb Professional before version 4.7, only the standard analysis might be visible because of license issues. In that case, please contact us at support@netfabb.com. You will get a new license file to activate the two analysis options.

An analysis of a selected part can be obtained by a click on the analysis icon in the toolbar, in the Extras menu or in the Extras submenu of the context menu of a part. You get a submenu where you can choose from the three kinds of analyses.

The analysis opens a window in the tabsheet providing information on the part. The content depends on which analysis you have chosen. Information on all of your analyses is listed together (Figure 6.1). In the project tree, a folder "Part analysis" is added as sub element to the part. All analyses are added to that folder (Figure 6.2). You can add an indefinite number of analyses.
Figure 6.1. The analysis of parts is displayed in the tabsheet. Left: The standard analysis. Right: The results of the upskin and downskin analysis and of the shadow area analysis are below the standard analysis.

Figure 6.2: A group of analyses in the project tree.

You can remove single analyses with a double-click on the red X next to the analysis in the project tree. If you want to remove the whole group of analyses, use the red X next to the group "Part Analysis" or right click on it and remove it in the context menu.

6.1.1 Standard Analysis

The standard analysis provides information on the position, size, volume and area of a selected part, as well as its number of points, triangles, edges and shells. It provides information about potential damage to the part by showing the number of holes,
boundary edges, flipped triangles and bad edges, specifies the overall length of boundary edges and checks, if the part is closed and orientable. Thus, you can find out, if a part requires repair and which kind of repair it requires.

Additionally, the minimum, maximum and average value as well as the deviation are calculated and specified for edges per point, triangles per edge, triangle quality and edge length (Figure 6.1).

### 6.2 Simple Part Editing

Several simple part editing functions are available in the standard mode, including inverting the orientation of parts, mirroring parts, converting the size of parts according to length units, merging parts and separating the shells of a part. They apply to selected parts and are available in the **Extended** submenu of the context menu of the part(s) or in the Part menu (Figure 6.4).

![Figure 6.3: The shadow of this part is projected to the bottom plane.](image)

![Figure 6.4: The Extended submenu in the context menu.](image)
6.2.1 **Invert Part**

All triangles of the last selected part are inverted, with the outside turned inside and the inside turned outside. Parts with a valid orientation thereby become totally side-inverted and consequently get a negative volume (Figure 6.5). Inverted parts are made valid. The shape of an object is not changed by this process. You can either replace the original part or keep both.

6.2.2 **Mirror**

The selected Part is mirrored across the Y-Z-plane in direction of the X-axis. While the triangles of the new part have the same Y- and Z-coordinates as the original, the X-coordinates are turned around in relation to the overall X-dimensions of the part. Thus, the mirrored part has the same overall dimensions as the original, but the shape is turned around (Figure 6.5). It can either replace the old part or is positioned next to it.

![Figure 6.5: Valid and inverted cylinders. The inverted cylinder has regular specifications, but a negative volume.](image)

By rotation, it is possible to get the effect of mirroring a part across other planes too. If you wish a part mirrored across the X-Z-plane, you have to rotate the mirrored part by 180°

![Figure 6.6: Original and mirrored part](image)
around the X-axis. Accordingly, if you want a part mirrored across the X-Y-plane, you have to rotate the mirrored part by 180° around the Y-axis.

### 6.2.3 Convert Units

This feature adapts the length values of all axes to the same values in another unit, either from mm to inch or the other way round. Thereby, it scales the selected parts equally in all three dimensions, effectively changing its size. For example, by choosing "Inches to mm", an object with a length, height and width of 100.00 mm will grow to 100.00 inches. Choosing "mm to Inches", the conversion is conducted the other way round, with parts with the size of 100.00 inches getting a size of 100.00 mm. This feature can be necessary, if files are saved without length units by other CAD programs and the part is then loaded in the wrong unit.

### 6.3 Create Shell

This feature is available in the Extras menu or in the Extras submenu of the context menu of a part. It creates a new shell on the basis of the selected part. Depending on the parameters you enter in the dialog box, you can create a hollow part, an inner offset or an outer offset or a hollowing shell of the original, either as a three-dimensional mesh or as a sliced part.

![Figure 6.7: Four parts become one part with four shells.](image)

The shell thickness determines the distance between the outer skin of the original part and the new shell. Every point of the new shell will have that distance to the original. That
means that, for example, corners and edges are rounded off, when you make an outer offset (Figure 6.8).

A **hollow part** is the original part combined with a hollowing shell inside (see also "Hollowing shell").

An **inner offset** of a part is a new, correctly oriented part within the original. Its shape is based on the original part, only smaller, according to the shell thickness (Figure 6.9).

An **outer offset** creates a part based on the original with a specified distance of the skins, only that it is exceeding the original in size, seemingly enclosing that part (Figure 6.10).

A **hollowing shell** is an inverted part based on the shape of the original part. It is placed within the original part and has a negative volume (Figure 6.11). By merging the original and the new part, a hollow part can be created.

---

**Figure 6.8: The dialog box for creating shells**

![Image of dialog box for creating shells](image1.png)

---

**Figure 6.9: Inner offset (right) of a box**

![Image of inner offset of a box](image2.png)
As output type you can either create a three-dimensional part or a slice file. The creation of a slice requires much less calculation time. If you create a part, you can set the accuracy of the new shell. A very low value means that a finer triangle mesh may be created. This results in very precise offsets, but requires longer calculation time, both for the creation and for further handling of the part. If the result is smoothed, the corners of the new shell are rounded off and a better triangle mesh is created.

The Option Create Slice exports the respective object as a slice file and inserts it into the Slices section of your project. Therefore, no triangle mesh has to be calculated. You can edit the layer size, according to your needs, and the roundness of offsets (Figure 6.12).

If it is necessary for the offset to form a curve, the angle you specify for the roundness is the maximum angle of two adjacent corner points of the offset, with the original corner point as apex of the angle. Consequently, the offset curve becomes rounder and more precise, if the maximum angle is reduced.
Figure 6.12: If you create a slice instead of a part, you can set output parameters for layer thickness and roundness.

6.4 Simple Cutting

Simple cuts parallel to the main planes can be prepared in the standard interface, as all options can be found in the tabsheet (Figure 6.13). Parts can be cut in a right angle across the X-, Y- and Z-axes at specific coordinates, with a cutting plane parallel to the other two axes (Figure 6.14). By clicking on Execute cut, the Free Cut module is opened (chapter Error! Reference source not found.), with the same cutting plane in lace. There, you can adjust further settings and execute the cut. If you have set cutting lines across more than one axis, you have to choose in a dialog which plane you want to insert. The split parts resulting from the cut are treated as own, separate parts (Figure 6.17).
The value of the axis, across which a cut shall be performed, can be set by a regulator or by manual insertion of a value. Additionally, you can set cutting planes with the mouse. To set a cutting plane with the mouse, right-click on the orange box between the axis letter and the regulation bar and choose **Set cut** in the context menu. After you click on it, you can click on the part to set a cutting plane across the chosen axis, which runs through the point you clicked on. If you hold the left mouse button, a transparent plane is displayed as a preview. You can move it across the part by *drag & drop*. The plane is not inserted until you release the left mouse button (Figure 6.15).

To illustrate and preview the result of a cut without actually performing it, all active **cutting lines** are shown. With default settings, the cutting line across the X-axis is red, the cutting line across the Y-axis is green and the cutting line across the Z-axis is blue.
After a right-click on the field between the axis letter and the regulation bar, you can choose to show the corner points on the cutting line.

![Visualized points on a cut](image)

*Figure 6.16: Visualized points on a cut*

The buttons between the axis-letter and the regulation bar show you which components of the cut can be seen in the viewing screen. By clicking on that buttons, you can hide these components and show them again. The orange boxes to the left and right represent the display of sections of parts with lower and higher coordinates than the cut. Hiding these sections helps you to get an unobstructed view on the resulting split parts. The yellow line in the middle controls the display of the cutting line. If you click on it, it is hidden and shown again. A hidden cutting line is deactivated and cannot be transferred to the Free Cut module. It is shown and activated again automatically, if you change the coordinates for the axis.

These viewing functions can be combined freely and make the cutting function a powerful viewing tool, as you can see cross sections and the interior of parts. For example, you can scroll from top to bottom with the scroll bar of the Z-axis and hide the top section to see the horizontal cross sections of the part (Figure 6.17).
**Figure 6.17:** Cutting lines across all three axes with three different viewing options. First, everything is displayed. Second, sections before the cut across the Y-axis and after the cut across the Z-axis are hidden. Third, the cutting lines are hidden as well.

**Figure 6.18:** The resulting split parts of the cut above can be moved separately as own parts.

**Reset** sets back all cutting coordinates to zero and hides potential cutting lines. In the context menu of the axes (after right-clicking between the axis letter and the regulation bar) you can reset the cutting lines of single axes.

Cuts can be performed either for all parts or only for selected parts. Thus, all parts of a project could be affected by a cut. The setting you choose in this dropdown menu is adapted automatically in the Free Cut module.

After performing a cut, the cutting line of the axis which was selected for the cut is set back, the others remain. So, if you want to perform cuts across more than one axis, you can repeat the cutting process without the necessity of setting the second and third cutting line one by one. That way, one part is dissected into up to eight parts (Figure 6.18).

### 6.5 Extrude

**Extrude** lets you drag out shapes on the surface of a part. By clicking and holding you can draw a line on the surface. Just draw the line around the area you want to extrude.
Figure 6.19: The surface of a part can be extruded. The tool allows you to “paint” the exact preferred shape directly onto the part.

6.6 Distort Section

You can distort whole sections with **distort sections**. Click on a section where two or more triangles are tangent to each other and pull it out or push it in.

Figure 6.20: In order to extrude a section, place the mouse on the part, where 2 or more triangles are tangent to each other and pull them out while holding down the left mouse button.

6.7 Color and texture

This module enables you to add colors and textures to your parts. That way, you
can mark different shells for machine specific manufacturing, simulate later painting or simply send the parts to a printer / service that can print real colors. The feature is available in the Extras menu. (Figure 6.21)

If your parts contains textures already, they are listed in the tabsheet on the right. Below, you find the **display options** where you can show the triangle mesh, textures, colors and display the part transparent. (Figure 6.22) In the toolbar, there are six new icons. The first four functions are for coloring, the last two for texturing. (figure 6.79)

### 6.7.1 Coloring

The screenshot below shows a part that already contains color information but it needs to be improved. When you click on one of the coloring icons you switch directly to the colors tabsheet where you can choose a color (Figure 6.23). If you want to delete all colors, just use the white to overlay them. As mentioned above, there are four icons in the toolbar for coloring a part:

![Figure 6.21: The color and texture module displays the existing colors and enables you to change, improve, and add them.](image-url)
The pipette allows you to read a color from a specific triangle. This way, you can use the colors that already exist on the part.

With Paint on triangles you can add a color to single triangles. First choose a color in the tabsheet on the right and then click on a triangle. By holding the mouse, you can paint more than one triangle at a time. (Figure 6.24)

Paint on surface enables you to color larger areas. It works like a pen in any graphic programs. (Figure 6.25) In the tabsheet you can decrease or increase the radius to change the size of the pen. (Figure 6.27) The selection tolerance determines what area may be colored: the smaller the radius is, the less triangles will be colored and the other way round. (Figure 6.27)

If you want to color a complete mesh, choose Paint on shells and click on the regarding shell. (figure 6.81)

![Figure 6.22: In the textures tabsheet, all pictures are listed and display options can be changed.](image1)

![Figure 6.23: The coloring / texturing icons in the toolbar.](image2)
6.7.2 Texturing

You can also use image files and cling them to your parts. Therefore, use the two texturing buttons in the toolbar.

Project texture

In the Project texture mode, you see a preview of the texture and a new tabsheet. Choose in the tabsheet how the texture should be placed on the part. (Figure 6.26) Either simply projected, wrapped around the model like a cylinder or like a sphere. (Figure 6.26)

Projector, cylinder and sphere

In the texture projection box, choose an image file. There you can also set a checkmark if you want to texture the surface that’s facing to you or also the backside. The preview plane will then display the image and you can scale, rotate and place it by using the blue dots or enter exact values in the tabsheet. (Figure 6.27)

If you want the image not only to be used once but to be repeated on the whole surface, check the repeat texture box. You can also check Just connected faces, to apply the texture only to the surfaces, it is currently connected to. To apply the texture, click on project.
Figure 6.24: The coloring tabsheet.

Figure 6.25: Left: A few colored triangles are missing. Right: The part was improved by coloring single triangles.
Figure 6.26: Left: Coloring a part with a pen in the Paint on surfaces mode.

Figure 6.27: The settings tab for the coloring mode. Adjust color and size of the coloring pen here.

6.7.3 Add advanced texture

In the advanced mode, you can cut out which specific area of a part you want to texture and also which specific area of the image you want to use. First, choose an image in the texture field in the tabsheet. Then begin with defining the textured area. You can do this with a few clicks on the part. Then define the texturing area in the picture (Figure 6.28). For each click, blue dots on the part and in the grid will appear. By dragging
these dots you can define this area more precisely. With a right click on the dots you can delete or reset the points.

This mode works similar to the projector mode, with one difference: The advanced mode wraps the image also in undercuts; the projector doesn’t (Figure 6.29).

![Figure 6.28: Left: A selection tolerance below 90°. Right: Here’s the tolerance above 90° and the pen now also covers the ancient side of the box.](image)

![Figure 6.29: One complete shell colored with the Paint on shell mode.](image)

![Figure 6.30: Preview of texture and the texturing tabsheet.](image)
Figure 6.31: Left: projector, middle: cylinder, right: sphere.

Figure 6.32: Left: the part with a preview of the texturing plane, middle: a preview of the texture, right: the textured part.

Figure 6.33: Left: the part with a preview of the texturing plane, middle: a preview of the texture, right: the textured part.
Figure 6.34: Left: the part with a preview of the texturing plane, middle: a preview

Figure 6.35: Left: Define the area on the model that should be labeled. Middle: Then define the according area in the picture. Right: Preview of the labeling.

Figure 6.36: Two pictures on the left: Part textured in the project mode. Two pictures on the right: In the advanced mode, also the undercuts are textured.
6.7.4 Texture imposing

After you projected an image file on your part you are able to use this file for grey scale imposing. This way, you can create more or less complex surface textures without having to use a CAD software or a structure tool.

![Figure 6.37: A 3D model from a square gets a teen unwrapped texture of a golf ball. With the texture imposing, you get a structured surface on the sphere, just like a golf ball.](image)

Color or texture your part as described in chapters 6.7. For the image we recommend to use a grey scaled one. After clicking on **Project**, switch to the **Extrude** tab.

![Figure 6.38: After projecting a texture or coloring a model, you can impose the image in the Extrude tab.](image)
With **Refine edges**, you can increase the resolution of the sphere’s triangle mesh. The lower this value is, the finer the mesh becomes and the better the imposing will be. But be careful with very small values, as the calculation times will increase.

The **White** and **Black movement** defines, how the black, white and grey areas should be extruded. A + value will pull these areas out of the original geometry (like an outer offset) and the - value subtracts them.

If the image is wrapped around the whole part, you can work with extruding the **whole part**. But if the image is only projected on a specific area of the part, it’s also possible to only extrude the regarding area. The directory of the image is automatically chosen then.

Below, you find the **display options** where you can show the triangle mesh, textures, and colors and display the part transparent. Perform the calculations with **Extrude** and then **apply** the calculations.

As a result, you see a golf ball structure on the sphere. For finer results, we recommend to smoothen the surface afterwards (Figure 6.37).

![Figure 6.39: Left: the result of the texture imposing. Right: The improved surface after a smoothing process (here with 5.00 iterations) in the Mesh](image)
7 Part Repair (partially in netfabb Private/Pro only)

7.1 The Repair Module

Whenever any part is damaged and therefore cannot be used for 3D printing, a large warning sign with an exclamation mark is displayed in the bottom right of the viewing screen, and a little warning sign is placed next to the part in the project tree (Figure 7.1). Before building these parts, they must be repaired.

The fastest way to repair one or several parts is to select them and click on the shortcut icon **Automatic part repair** in the tabsheet on the right. A dialog opens where you can choose between three predefined repair macros (see chapter 7.6 for more information on the single scripts.) You can either use these predefined macros or define your own ones (e.g. with an automatic scaling or naming of parts - see chapter 7.6, also). Like this, you can automatize and speed up your processes.

For a more controlled repair, select a part and start the repair module with the red cross icon in toolbar, in the Extras submenu of the context menu or in the Extras menu in the menu bar.

The viewing screen then switches to the **repair screen**, which includes only the selected part. In the tabsheet, you can choose from five registers, "Status", "Actions", "Repair scripts", "Shells" and "View". In the menu bar, the menus Repair and Mesh Edit are added. In the project tree, the repair is integrated as subordinate element of the part. After conducting other operations, you can return to the repair any time by selecting the repair in the project tree. You can also add other parts to the repair module by drag & drop in the project tree. That way, you can repair several parts at once.
Figure 7.1: Left: This caution sign in the bottom right of the screen indicates that one or more parts in the project are damaged. Right: The warning signs indicate that parts 3 and 4 are damaged.

With the repair module you can repair your files automatically, semi-automatically or manually by flipping inverted triangles, closing holes, calculating and removing self-intersections, stitching triangles and removing double faces and degenerated triangles. netfabb Professional also offers features to edit the triangle mesh: You can cut surfaces, extrude surfaces or edges, reduce the number of triangles and refine and smooth your mesh.

In the **Status** register of the tabsheet, statistics are provided concerning the state of and the damage to the part. It includes the number of edges, border edges, overall triangles, triangles with invalid orientation, shells and holes. After performing a working step on the part, the statistics can be updated by a button. By selecting "auto-update", the statistics are constantly monitored and updated (Figure 7.2).

Figure 7.2: Information about the properties and damages of the part are given in the tabsheet.

When you are finished with your repair operations, the repaired object is inserted into the project by clicking on the **Apply** button in the tabsheet, by double-clicking on the green tick next to the repair in the project tree or in the context menu after right-clicking on the repair. On request, you can either Remove old part (the original part will be deleted and replaced by the new repaired part), keep old part (the original part will remain and the
repaired part will be copied), keep and compare (see chapter **Error! Reference source not found.**) or cancel (Figure 7.3).

![Figure 7.3: Apply the repair and choose if you want to delete or keep the old part - the repaired part will then be copied into the platform. You can also compare the two meshes (see chapter **Error! Reference source not found.**).](image)

With the Undo-function in the Edit menu, you can go back to different stages of your repair. With Redo, you can perform the process you have undone Repair functions are available in the tabsheet, in the Repair and Mesh Edit menus in the menu bar and in context menus, depending on where you right-click on the screen.

### 7.2 Repair Viewing Options

The viewing options in general are very similar to those in the normal interface. All perspective settings and the zoom functions with the mouse are identical (chapter 4).

#### 7.2.1 Zoom and visualization

The default zooming options are replaced, as there is only one part on the screen and single triangles can be selected. They are:

- **Zoom on Part:** The part is moved into the center of the screen and the zoom is reset so that the part is adjusted to the edges of the screen.
- **Zoom on Selected Triangles:** The zoom is reset so that selected triangles are in the center of the screen and these triangles fit exactly into the frame of the viewing screen.
- **Zoom to Selection:** This feature enables you to drag a selection rectangle when
holding the left mouse button. netfabb then zooms in to that selection. By ticking the respective boxes in the visualization settings in the "Status" register, you can choose whether to highlight holes with a yellow line, show degenerated faces, visualize the triangle mesh and highlight errors with a thicker line. Errors can also be highlighted during operations by holding the H-key (Figure 7.4).

Figure 7.4: The visualization settings in the tabsheet

If the triangle mesh is not shown, there is the option to visualize triangle edges exceeding a certain angle which can be adjusted with a slider. Here, 0° stands for triangles lying in the same plane and all angled edges are shown, while with 180° (or off), no edges are visualized (Error! Reference source not found.). The setting of this regulator also has an influence on the selection of surfaces (see chapter 7.3).

7.2.2 Hide selected surfaces

After you have selected triangles or a surface (see chapter 7.3 Selection) you can hide this selection. Either open the context menu with a right click and choose Hide triangles or press the Shortkey I (for “invisible”). In order to view the selection again, press V (for “visible”), Figure 7.5.
7.3 Selection

Basic Selection

For the repair module, there are several selection options. Depending on the chosen selection mode, either single triangles, all triangles of surfaces or all triangles of shells can be selected with a mouse click (Figure 7.6). With default settings, selected triangles are colored green on the outside and darker green on the inside, while unselected triangles are colored blue on the outside and red on the inside.

If the Ctrl key is held, triangles, surfaces or shells can be deselected or added to the selection with a mouse click. If both the Ctrl key and the left mouse button are held, all triangles, surfaces or shells crossed by the mouse cursor are either added to or removed from the selection, depending on whether you first click on a selected or on an
unselected triangle. Holding the Shift key instead of Ctrl works similarly, but only for adding to the selection.

Alternatively to selecting with simple mouse clicks, single triangles, surfaces or shells can also be selected in the context menu without changing the selection mode. If you are selecting single triangles or even using one of the manual repair modes (see chapter 7.4), you can select a whole shell by right-clicking on it and choosing "Select this Shell" in the context menu. The same goes for triangles and surfaces.

After activating the mode selection primitive in the toolbar, you can select all triangles or shell within a rectangular or circular frame by holding the left mouse button and dragging the frame (Figure 7.7). Choose between the four different modes of selecting:

- **Select all triangles**: All triangles that lie within the rectangle, no matter if they are at the backside of the part or covered by another surface, will be selected.
- **Select front-facing triangles only**: Triangles that face to the front will be selected, even if they are covered by other surfaces.
- **Select uncovered triangles only**: Triangles, which face to the front or back and that are not covered by other surfaces will be selected.
- **Select front-facing and uncovered triangles only**: Only those triangles that you can actually see from your current perspective and are facing to you will be selected.

**Shells** also allows you to use the rectangle to select whole shells instead of just triangles.

*Figure 7.7: Left: Drag a rectangle with the mouse. Right: The resulting selection.*
The advanced triangle selection can be accessed through the edit tab in the menu bar and gives you the possibility to select triangles that are not necessarily located next to each other by setting different parameters. It would be possible for example to select all triangles with a bad quality to replace them in order to get a nicer mesh.

Figure 7.8: Chose the preferred criteria from the tabs. To set a value you can also click on the histogram to choose the respective triangles. Then click select to make the choice visible.

As you can see in Figure 7.8 you can choose from these attributes: Triangle Area, Shell Volume, Edge Length, Triangle Quality and Up-Downskins. You can decide whether the selected triangles are supposed to be above or below the set value, by checking the respective box. It is also possible to check both boxes to create a range. You can also click on the bars of the histogram, to set the values. Using the histogram when both boxes are checked will select the exact quantile reflected by the bar. Checking the upper box will select all triangles above the set threshold and vice versa.

Additionally, there are three default selections available in the toolbar or in the part’s context menu. They select either all triangles, toggle the
selection, which means that selected triangles are deselected and deselected triangles are selected at the same time, or **clear the selection**, with all triangles becoming deselected.

**Surface Selection Parameters**

The **selection of surfaces** is closely related with the visualization settings for edges. netfabb will interpret adjacent triangles as one surface, if the angle of the edge separating them is below the specification (and therefore is not visualized if the triangle mesh is switched off, chapter 7.2.1).

Additionally, by setting the **selection tolerance** at the bottom of the Status register, you can define the maximum angle between triangles becoming part of a surface and the triangle you click on.

So, when surfaces are selected, there are two different calculations for every triangle in question. First, the angle of the triangle to adjacent triangles which belong to the surface. Second, the angle of the triangle to the triangle clicked on. Both can be the limiting factor for the surface (Figure 7.9).

![Figure 7.9: Surface selection limited by the visualization of edges (left) and the selection tolerance (right).](image)

**The Shell List**

If you click on the **Shells register** in the tabsheet, you can obtain a list of all shells of the part. The following attributes of the shell are listed: Number of Triangles, overall area of all triangles, outbox volume (a cuboid frame enclosing the shell), shell volume, water tightness, orientability and outbox dimensions. The volume of the shell can only be given, if the shell is watertight (Figure 7.10). With the horizontal scroll bar below, you can scroll to the right to see all attributes. Optionally you can enlarge the whole context area (by **drag & drop** on the edge of the context area) to give the shell list more room.
If you click on one of these attributes, the shells are sorted according to that value, first from the highest to the lowest value and with another click from the lowest to the highest. This gives you a well-arranged overview over your shells.

If the box **auto-select** is ticked and you click on one of the shells, it is selected. It is marked blue in the list and, just as normal selections, green in the screen (Figure 7.11). If you hold Ctrl, shells can be added to or removed from the selection, although selections conducted in the screen will always be cleared. If you hold Shift, all shells are selected which are listed between the last shell you clicked on before holding shift and the shell you select now.

![Figure 7.10: The Shells register in the tabsheet lists all shells of a part.](image)

If you perform any editing or repairing function, naturally, the attributes of your shell change and the information given in the shell list may be invalid. In that case, the shells in the list are colored red. To update the list, click on the **Refresh** button below (Figure 7.11).
Figure 7.11: The red colored text indicates that the part has been edited and the shell list is no longer up-to-date. Choose Refresh to update it.

So, with the shell list, you can sort your shells according to certain attributes and select them. For example, if you have a part with many tiny shells which you want to remove, you can sort them according to their area and then select them by clicking on the first and then clicking on the last you want to select, holding shift. That way, all tiny shells are selected at once and can be removed with the Delete key.

Additional Selection Options

Whenever you have selected triangles or surfaces you can expand or shrink the selection in the context menu or by pressing Plus or Minus. If you expand the selection, all unselected triangles adjacent to the current selection are added to the selection. If you shrink the selection, all selected triangles adjacent to unselected triangles are removed from the selection.

If a part has holes, all surrounding triangles can be selected by right-clicking on the edge of a hole and choosing Select surrounding triangles. Alternatively, if you click on Select Attached Triangle Only, only the triangle to which the edge belongs is selected. That way, it is much easier to select tiny triangles along open edges, which may be created while working on the triangle mesh.
In the Actions register, the button **Select Shells with Negative Volume** enables the user to select all inverted shells. This function is very useful to select and then invert or remove those shells. However, it is only reliable for closed and oriented shells.

Finally, you can perform an **advanced triangle selection**. Choose the option under edit in the toolbar and use the dialog box to select or deselect triangles above or below (or both) a certain area, volume (of the shell) and edge length (Figure 7.12).

![Figure 7.12: The dialog box for the advanced triangle selection](image)

### 7.4 Manual Repair (partially in netfabb Private/Pro only)

With manual repair operations you can perform simple repair and mesh editing jobs. The manual operations are available in the toolbar. "Remove selected triangles" and "Flip selected triangles" are also available in the Repair menu and in the context menu, if you right-click on a selected triangle.

**Add triangles:** This mode enables you to close holes manually or to connect edges.

A triangle is created by first clicking on a border edge of a triangle, which is then marked in a blue color. Now, if you move the mouse across another border edge, you get a green preview of potentially added triangles. By clicking on another border edge, triangles are inserted. If the two edges you clicked on are connected by a common corner point, it is one triangle. If they are not connected, two triangles are inserted. If any border edges of the new triangles are neighboring other border edges, these are connected automatically (Figure 7.13).
**Add nodes:** In effect, this mode enables the user to refine the triangle mesh manually by inserting new corner points. A corner point can be inserted by a mouse click on a triangle. New edges are inserted, connecting this point with the three corner points of the old triangle. So, one triangle is split into three (Figure 7.12). If a node is placed on an edge, both adjacent triangles are split into two triangles. As long as the left mouse button is held down, the node is not placed and can be moved across the surface to the favored position. At the same time, you can see a bright blue preview of the new triangles. The shape of the part does not change, though the nodes can play a vital role during further repair operations.

**Move nodes:** netfabb is basically a software for file preparation, not for constructing. Holes and other errors therefore are repaired in the simplest way: A hole is usually closed by a plane, a curve won’t be adapted. This can cause troubles, especially
with scans. (Figure 7.15) But with the Move nodes mode you can easily tweak the model and tinker the curves.

![Figure 7.15: Left: A scan with holes. Middle: Holes are usually closed by a plane. Right: detailed view on the plane. - You can tweak these surfaces and reproduce the curves (see below).](image)

When the mesh is very irregular, you should add nodes on the plane first (see Add nodes above). Then choose the move nodes mode and pull the nodes with the mouse. (Figure 7.16)

Then you can continue repairing the file. You can for example delete unwanted bumps, close the holes (Figure 7.17) and smooth the new surface (Figure 7.18).

![Figure 7.16: Left: Add nodes first to have better control over the mesh. Right: Pull the nodes with the mouse.](image)
Remove selected triangles: Selected triangles are deleted. This can also be done by pressing Delete.

Flip selected triangles: The inside and outside of selected triangles are turned around. Thus, the triangles are inverted.

Figure 7.17: Possible further editing (a): delete unwanted triangles and close holes.

Figure 7.18: Possible further editing (b): select new surface and smooth it.

7.5 Semi-Automatic Repair

Semi-automatic repair options are applied to the whole part or the whole selection of triangles, surfaces and shells. They can be found in the context menu and in the Repair menu. The most important are also available in "Actions" tabsheet (Figure 7.19).
There are three ways to close holes without manually inserting the missing triangles. First, after right-clicking on the edge of a hole (marked yellow, if the visualization option "Highlight Holes" is activated), you can choose the option Close Hole in the context menu. Thus, single holes can be closed. The triangles inserted to fill the hole are automatically selected.

By clicking on Close trivial holes, all holes are closed that require either one single triangle or for which only two border edges with the same corner point coordinates have to be connected.
By clicking **Close defined holes**, you can define to only close holes that have a certain edge length. You can either close holes from a minimum edge length, to a minimum edge length or both. Just check the respective boxes and set their values.

By clicking **Close all holes**, all holes of the part are closed automatically. This is surely the simplest method to repair holes. However, with complicated holes regarding geometry or orientation, it may lead to unsatisfactory results (Figure 7.20).

*Figure 7.20: After right-clicking on open edges, you can close single holes in the context menu.*

*Figure 7.21: Left: For these holes only one triangle is missing. They can be repaired with Close Trivial Holes. Right: Close All Holes automatically tries to repair all holes, no matter how complex they are.*
7.5.1 Self-Intersections

Self-intersections occur whenever triangles or surfaces of one part cut through each other. Netfabb is able to detect, split off and remove those self-intersections.

If you detect self-intersections, a red line will appear representing the cutting line of self-intersections. This line is also visible, when the intersections are within or at the backside of the part. If surfaces not only cut through each other, but are on top of each other, all triangles which are part of that double surfaces are marked in orange (Figure 7.22).

![Figure 7.22: Left: A Self-Intersection with two shells cutting through each other. Right: All triangles belonging to a double surface in the interior of the part are marked orange.](image)

By splitting off self-intersections, intersecting surfaces and double surfaces will be cut and divided along the cutting line, resulting in border edges along the intersections. If the surfaces are part of closed shells, sections of this shell will be cut off and can be selected and worked on separately as own shells.

The triangle mesh is changed (without changing the shape), so that neighboring border edges have identical coordinates and you get a valid triangulation across the two shells. This is done to provide easier processing when repairing the intersection (e.g. by stitching the triangles).

If you remove self-intersections, the intersections are split off, resulting interior shells and double surfaces are removed and surfaces on the outside of the part are
reconnected. As a result, a valid shell is created (Figure 7.23). Self-intersections can only be removed, if the part has no holes.

![Image](image.jpg)

*Figure 7.23: Here you can see the interior of a part with removed self-intersections. Interior surfaces are removed and a valid shell is created.*

### 7.5.2 Stitch Triangles

With this function, adjacent triangles are connected. Therefore, points of triangles in an identical position and the adjacent edges are merged. These edges are marked yellow, if the option "Highlight Holes" in the tabsheet is activated. Whenever the corners of triangles are not exactly in an identical position, they are moved together. Thereby, the shape of the part is distorted very slightly. Here, the tolerance setting determines the maximum distance corners are moved (Figure 7.24). The stitching of triangles can either be executed only with selected triangles or with all triangles. If you stitch only selected triangles, both triangles which are to be connected have to be selected. Optionally, you can ignore the orientation of triangles. If you do so, triangles with opposing orientation will be connected as well. If you do not tick this box, the software stitches only triangle edges with fitting orientation. In general, it is recommended NOT to ignore the orientation, in order to prevent the creation of non-orientable triangle meshes.
Figure 7.24: Open triangle edges can be repaired with the Stitch Triangles function.

7.5.3 Fix Flipped Triangles

Inverted Triangles are turned around. This is indispensable for repairing parts with an invalid orientation. In the Status tabsheet, you can see, if you have triangles with invalid orientation. The orientation of triangles can be seen easily, as the outside is blue and the inside is red (with default settings, Figure 7.25). In the Status tabsheet, you can see, if you have triangles with invalid orientation.

Figure 7.25: The inside of triangles is red so that flipped triangles can be seen easily.

If the part is not orientable, a dialog is opened where you will be asked if netfabb should try to make it orientable (Figure 7.26). However, as a warning, this does not always work and may destroy the mesh. So, to be sure, it is recommended that you apply the repair before executing this function, optionally without replacing the original, and start the repair module again. Not orientable surfaces can come into being for instance because of self-intersections, or after the orientation is ignored during the stitching of triangles.
Figure 7.26: In a dialog box, you are asked whether the part shall be made orientable.

7.5.4 Remove Double Triangles

Removes triangles using the same three corner points, irrespective of their orientation. One of the triangles is kept (Figure 7.27).

Figure 7.27: Triangles with the same coordinates but different orientation.

7.5.5 Select Overlapping Triangles

Overlapping triangles are those that touch or almost touch each other, no matter what angle or orientation they have. The Overlapping triangles detection function is available in the context menu after a right-click on the screen.

In the dialogue, you can determine the max. distance of parts. All triangles below that value will be selected. Same with the max. angle. Below you can set the direction of the triangles. With Parallel, all triangles that have the same orientation, will be selected. With Antiparallel, it’ll be all triangles with an opposite direction. Or you can also select in both directions. If you want to fix your parameters as standardized settings, press Save.
settings as default. If you want to get back to previous values after you’ve changed them, click on Restore settings.

7.5.6 Remove Degenerate Faces

Degenerate faces are triangles which have no surface or only minimal surface. In the repair screen, they are marked orange (Figure 7.28). As they do not construct any surface, they usually are unnecessary. They can come into being during various operations, such as file conversion, Boolean Operations and all kinds of operations which involve retriangulations. Degenerate faces in a file principally do not result in bad parts when manufactured, but they may dramatically increase the number of corner points and hatches in the slice files necessary for the production. This may cause much longer calculation and production times.

With this function, the degenerate triangles are deleted. By setting the tolerance, you can set the maximal edge length and height of the triangles which shall be deleted.

7.5.7 Refine triangle mesh

In order to refine the mesh of your triangle you can set a minimum edge length with this function.

7.5.8 Extract Selected Triangles As Part

The current selection is inserted into the project as own part and is added to the parts section of the project tree. That way, for example, surfaces or single shells can be added to the project for subsequent operations (Figure 7.29). On request, you can either keep the extracted triangles in the repair or delete them.

This function can be used to start a second repair module for the extracted sections or shells only. So, you can conduct general, semi-automatic repair operations only for these extracted triangles. If you do so, delete the selection when you extracted them from the first repair and, after you have applied the second repair, use drag & drop in the project tree to move the part back into the first repair.
Figure 7.28: The orange-marked triangle has no and consequently looks like a one-dimensional line.

Figure 7.29: Make a selection and extract it as own part.

7.5.9 Split Non-Oriented Edges

If triangles with opposing orientation are connected in a mesh, they are separated by this function (Figure 7.30).

Figure 7.30: Edges with opposing orientation are split off, resulting in two boundary edges.
7.6 **Automatic Repair** (partially in netfabb Private/Pro only)

By clicking on the "Automatic Repair" button in the tabsheet or on "Automatic Repair" in the context menu or Repair menu, one of several repair scripts can be executed. Thereby, predefined repair operations are executed in a predefined sequence. The simple repair, the default repair and the extended repair are already prespecified and cannot be altered (Figure 7.31). The simple repair automatically fixes flipped triangles and first closes trivial holes and then all holes. The default repair automatically performs most semi-automatic repair functions. The extended repair is the most powerful one and additionally wraps the part in order to delete unwanted inner shells or doubles triangles.

![Figure 7.31: Choose one automatic repair option in the dialog box.](image)

In the **Repair Scripts** register of the tabsheet (Figure 7.32), you can define individual repair scripts, as well as view, edit and save existing and new automatic repairs. The drop-down menu at the top shows you which repair script you are currently working on. New scripts can be created by clicking on the button with the blue plus-icon. If you want to remove existing scripts, double-click on the red X.

In between, there is a button depicting a gear wheel. After clicking on that button, you can load scripts, save the current script, duplicate your script or rename it.

The field below shows which repair functions are performed in which sequence by the script. The sequence of the repair functions can be changed by clicking on one of them and moving it by **drag & drop** within the list. By clicking on the green tick next to a listed function, you can perform one function separately, and by clicking on the button with the red X, the function is deleted from the script.
Some operations in the script have a little Plus on the left side. If you click on it, a tree is opened and you can view and edit the parameters of these functions, for example the tolerance (Figure 7.32).

![Repair Script of Default Repair.](image)

**Figure 7.32: Repair Script of Default Repair.**

**Figure 7.33: Specifications for the function "Stitch Triangles" can be altered within the repair script.**

Below the field containing the chosen functions, there is a drop-down menu which includes all repair functions which can be added to a script. This can be done by selecting a function and click on "Add". Clicking "Clear" deletes all functions from the script. Finally, the repair script can be saved to your disc, for example to be copied to other computers, or it can executed directly.
8 Measuring and Quality Assurance

8.1 The Measuring Tool

The measuring tool is activated by selecting a part and clicking on the measuring icon in the toolbar or choosing New Measuring in the Extras menu or Extras submenu of the context menu.

It allows the measurement of distances between points, edges and surfaces, as well as radii and angles. It opens the measuring screen with the selected part only and provides all measuring options in the tabsheet, where instructions are given and all measuring results are specified in detail (Figure 8.1). The options for changing perspectives and zooming in the measuring screen are the same as in the main screen, only with less default zoom options.

In the project tree, the measuring is integrated as subordinate directory of the part, with single measuring operations as subordinate elements to that directory. After conducting other operations, you can always return to the measurement by selecting it in the project tree. If you right-click on the measuring in the project tree, you can rename it or remove it (Figure 8.2).

The measurements are performed by the setting of anchor points. It is possible to define any number of measurement operations in the same screen and measuring. For a subsequent quality test, it is also possible to set anchors in order to add notes. When a measurement is conducted, a blue line (=arrow) appears between the anchors and the result of the measurement is shown in a small box in the middle (Figure 8.3). Also, a new anchor is created in the center of the measurement, either in the middle of a distance or in the center of a radius or at the apex of an angle. All anchors can be used again for subsequent measurements.

The box specifying the measured value represents a measuring point and, by drag & drop, can be moved sideways together with the blue line into a parallel position. In that case, the ends of the line are connected to the anchors by two more arrows, and the measured distance is marked by a more conspicuous yellow measuring line, if the option
"Show anchors" (see below) is activated. That way you can get a good overview of measurements and it is easier to use the central anchor (Figure 8.3).

Figure 8.1: The tabsheet offers various measuring options.

Figure 8.2: Rename or remove a measurement through the context menu in the project tree.

A measure point is selected by a left-click and can then be removed by pressing the Delete key. By right-clicking on the box with the measured value or on the respective measurement in the project tree, a little context menu appears, in which the measuring point can be either edited or removed (Figure 8.4). Editing the measuring point, you can add notes to the measurement and change its appearance regarding the arrow color, font color, border color, background color and level of transparency (Figure 8.5). If you show the hidden arrow, the yellow measuring line will also have the color of the remaining arrows. By deselecting "Show Value", the result of the measurement is hidden. If you remove the measure point, the whole
measurement is removed, including its anchors and all other measurements using these anchors.

Figure 8.3: Left: Measurement between two points on a Surface. Right: Measurement of point on edge to a corner point. The measuring arrow is dragged sideways, providing a good view and access to the central anchor.

Figure 8.4: Context menu of a measuring point.

Figure 8.5: Edit Appearance dialog box
8.1.1 Cutting Lines

You can also set cutting lines on your part. These cutting lines can be used to set anchors to specific coordinates (figure 9.6). Cutting lines can be edited with the regulation bars at the bottom of the tabsheet below the measuring options. It is also possible to hide and show sections of the part before and after the cutting line. For a description of the exact use of the cutting options, see chapter 6.4. To set cuts with the mouse, you can right-click anywhere on the screen and choose a cut across any axis, which you can then set by clicking on the part.

8.1.2 Setting Anchors

All measurements are defined by anchor points. They can be placed simply by a mouse click. If you hold the left mouse button, you can still move the mouse before placing the anchor. A preview of the measurement, including the measured value, is displayed, changing as you move the mouse across the part. At the same time, you can rotate and shift the view and zoom in or out with the mouse, which enables you to place your anchors very precisely. The anchor is set as soon as you release the left mouse button. There are several options for the setting of these anchors:

![Figure 8.6: Measurement of a surface to a point on a cut.](image)

**Point on Surface:** The anchor is placed wherever you click on the surface of the part.
**Point on Edge:** The anchor is placed on an edge of the surface. If you do not click exactly on the edge, the software sets the anchor point on the closest edge.

**Corner Point:** The anchor is placed on the closest corner point of two or more edges.

**Point on Cut:** By clicking on or close to the cutting line, an anchor is placed on the cut.

![Figure 8.7: Measuring of point on cut to corner point](image)

**Corner Point on Cut:** Places anchor on a corner of the cutting line.

![Figure 8.8: Measuring of two corner points on cut.](image)

**Show Anchors:** With a click on the icon to the right, anchors can optionally be shown as a yellow rectangular point (default). When this highlighting of anchors is
switched off, the yellow measuring line, which is visible when the measuring point is
dragged sideways, will disappear as well, making place for the normal arrow.
These anchors can be used either for measuring distances, angles or radii. The
measurement is conducted by first choosing the measuring options and then setting the
anchors. It is possible to set the anchors of one measurement with different options.
Depending on what you want to measure, you have again several options:

8.1.3 Measure Distance

By clicking on a surface, the distance to the next opposite surface
is calculated, with the measuring line running in a right angle inwards from the
selected anchor (Figure 8.9). For hollow parts, this is usually the wall thickness, for solid
parts it is the diameter of the part at this point.

(Figure 8.9: Wall Thickness)

Point-to-Point: The distance of two anchors is measured, which you can place
freely on the part, taking into account the anchor setting options above.

Point-to-Line: Calculates the shortest distance from any point to a line running
along an edge, with an imagined extension beyond both of its ends on the part
(Figure 8.10).

Line-to-Point: As Point-to-Line, but select first the line, then the point (Figure
8.10).
**Figure 8.10: Measurement of point to line. The Line is extended beyond its corners.**

- **Line-to-Line:** Calculates the shortest distance between two lines. For two lines cutting through each other, this distance is 0. Otherwise the points on the lines which are the closest together are taken as anchor points for the measurement. Again, for the measurement, the lines are extended beyond its end points on the part.

- **Surface-to-Point:** Calculates the distance from a surface to a point. Click first anywhere on the surface, then set an anchor anywhere on the part. For the measurement, the surface is extended beyond its edges (Figure 8.11).

**Figure 8.11: Left: To measure the distance between a surface and a point, first click on the surface. Center: When you hold the left mouse button as you set the second anchor, a preview of the surface is displayed. The surface is extended beyond its edges. Right: The result of the measurement.**
8.1.4 Measure Angles

There are two methods to measure angles, after clicking on the icon for measuring angles in general:

Three points: With that option, you can set anchors anywhere. The first anchor determines the first arm, the second anchor determines the apex and the third anchor determines the second arm. netfabb calculates the angle between the two arms, which run from their anchor through the apex (Figure 8.12).

Two Edges: Anchors will always be placed on edges. Click on two edges to get the angle between them. The edges are extended beyond their corner points on the part. If the edges do not cut through each other, one edge is moved parallel so that they do cut and an angle can be calculated (Figure 8.13).

Figure 8.12: Measurement of the angle between the top surface and the side edge by three points.
8.1.5 Measure Radius

It is possible to measure the radius of both circles and spheres. The specified value is the diameter of the circle or sphere. You can place the anchors for the measurement freely with any of the anchor setting options:

- **Circle Arc**: Click on a circle on the part or on a smooth curve to get its radius.

It is not necessary that the curve forms a complete circle (Figure 8.14).
**Three Points on Circle**: Select three anchor points anywhere on the part. A circle running through these points is calculated and its radius is measured (Figure 8.15).

**Four Points on Sphere**: Calculates a sphere through four anchor points and specifies its radius and its center (Figure 8.16).

### 8.1.6 Add Note

With this option, the user can place anchors to add notes. In a dialog box, the appearance of the note can be changed in terms of the arrow color, font color, border color, background color and level of transparency. This can be done in a similar way to the editing of measure points.

*Figure 8.15: Radius measured with three points: By measuring three edges of the top surface, new anchors are created in the center of these edges. These anchors can be used to calculate the radius of the inner circle of the surface.*
8.1.7 Set Default Modes

After right-clicking on the icons in the tabsheet, you can set your default measuring mode. netfabb remembers your settings for setting anchors and for your measuring tools. If you click on "Use this mode as default" or "Use this tool as default", this option will be activated at the start of all measurements from then on (Figure 8.17).

Figure 8.16: Radius of a sphere, gained by selecting four anchor points on the dome. Also, an anchor is set at the center of this half-sphere.

Figure 8.17: After a right-click on the buttons in the tabsheet you can make the respective options your default settings for future measurements.
8.1.8 Lock and Unlock View

To the right of the measuring in the project tree, there is a little icon to lock or unlock the perspective. This only plays a role, when a second measuring or a test of the part has been added and you switch back from that other measurement or test. If the view is not locked and you return to the measuring (click on it in the project tree), it always takes over the perspective from the element opened before.

If you want netfabb to remember a perspective, lock the view. The perspective of the measuring is saved at the moment you do so. As long at the view stays locked, netfabb always goes back to that perspective when you return to the measuring. It does not matter, to which perspective you have rotated the view in the same or in another measuring.

That way, you can choose a separate perspective for each of your measurements and keep this perspective for subsequent tests.

8.2 Test

The testing function can be started in the toolbar and adds a new test directory in the project tree, within which subordinate elements are available to conduct tests (Figure 8.18). Specifications can be entered in the tabsheet below. The tool can also be accessed in the Extras menu of the Extras submenu of the context menu of the part.

You can test the quality of fabricated parts regarding their dimensions and other attributes. For the testing of dimensions, measurements conducted with the virtual part in netfabb serve as reference value. So, the testing function allows you to cross-check the measuring results of fabricated parts with measurements conducted in netfabb. Acceptable limits of deviation can be defined for each measured value.

If you right-click on the test, it can be renamed or removed entirely in the context menu. If you want to remove only some subordinate elements, right-click on that specific element and click "Remove".
8.2.1 Create Definition

To be able to get a useful test result, it is important to create a precise definition of the test. In the definition directory of the test in the project tree, all measurements conducted with the part are listed, with single measurements as subordinate elements.

If you click on the "Definition" directory or on a measuring (group of measurements), you can take offsets and scales into account, which are expected to occur during production, and you can specify general standard tolerances. These are acceptable values for deviations in general, measured in mm for distances, ° for angles and % for circle diameters (Figure 8.19). With the button "Apply", tolerances are calculated according to these values for all single measurements.

The single measuring operations (measuring points) are included into the test if the box next to their name is ticked in the project tree. If you click on the measurement, you can see the reference value, which is based on the measured value and could be modified by the general definitions, and you can insert the upper and lower acceptable value for every
measurement (Figure 8.19). The offset which you have set in the general definition, can be either added or deducted, depending on the option you choose in the dropdown menu. In the text field below, you can add notes for the test of this measuring point.

**Figure 8.19: Left: A general definition for all measurements. Right: The definition for a single measurement.**

**Values**
If you want to test other attributes of the part, click on the Add Value button after selecting the values directory, double-click on the blue Plus next to the directory or right-click on the Values directory and choose "Add Value" in the context menu. Then, add and specify additional values. You can insert the name of the attribute and choose one of three ways to define the criteria of the value: an exact value, as with measurements, a Yes/No distinction or a choice from several options (Figure 8.20).

**Figure 8.20: Left: Insert exact value and limits. Center: Yes or No can be defined as correct. Right: Choice from several options. By clicking on the Plus button, options are added. The ticked option is defined as correct.**
8.2.2 Test Result

When you click on the test in the project tree, the button "New Test Result" is available. The same is obtained by a double-click on the blue Plus next to the Test directory or in the context menu after right-clicking on the test. The test result is added to the test directory. You will see which measurement of the real manufactured part is within an acceptable range and which one is not (Figure 8.21).

In the test result, all measurements and values which are activated in the definition (by ticking the box) are listed. For every measurement and every value, the measured values must be inserted. If these values are within the defined tolerance, the attribute is colored green in the test result. If they are not, it is colored red (Figure 8.18).

![Figure 8.21: Left: Enter the measured value. Center: Specify, if the attribute is given. Right: Select the attribute which applies.](image)

8.3 Interlocking test

Access the interlocking test through the quick access icon bar in the bottom right corner of the default module. The test will check for any interlockings on the platform. That means two parts are entangled in a way that they can’t be separated after printing, but still no collision occurs.

![Figure 8.22: An example for two interlocking tori](image)
An interlocking will even be detected when one or both parts provide a gap to untangle the parts. The algorithm tries to “pull” the parts apart. But in some cases the part would have to be tilted in order to separate them. The algorithm does not account for that and therefore detects an interlocking

![Diagram of interlocking parts](image)

*Figure 8.23: Two parts that are detected as interlocked, even though they could really be separated*

### 8.4 Test for Z-removability

The test will check whether the build space can be unpacked by removing parts one by one in the upward direction with respect to the set minimal distance between parts. If that is not the case a collision will be detected.

![Diagram of test for Z-removability](image)

*Figure 8.24: Example for two parts where neither can be removed along the z-axis without a collision*
The Z-Removability test can either be accessed through the quick access icon in the bottom right corner of the default module or through Edit → Check Z-removability. The dialog will open where you can set your minimal distance between the items, start the test and also receive the result. The smaller the value for the minimal distance is, the longer the calculation time will be.

![Figure 8.25: Dialogue for the z-removability check](image)

The absolute minimal distance will be limited by your systems’ memory. A warning will be displayed when the minimal possible distance is undercut.

![Figure 8.26: Warning that the system might run out of memory during the calculation](image)

Too big of a value will result in false collision detections, as the grid that is used for the test will be set too coarse.
9 The Slice Commander (partially in netfabb Private/Pro only)

The slicing process dissects a three-dimensional part into two-and-a-half-dimensional slices. These are a collection of two-dimensional layers. The slice files are vital for manufacturing parts, as 3D-printing machines cannot read three-dimensional data. Furthermore, slices provide you with a visualization of cross sections of your part, and you get more detailed information about the object. You also have the chance to edit your slices before fabricating them. Many of these functions are also available in the three-dimensional data management. However, in the Slice Commander, you have the advantage that calculations are performed much quicker, as complex 3D-tasks are replaced by 2D-tasks. This reduces the complexity of the data handling. For slices, there is an own section in the project tree, where all slices are organized in the same way as parts in the part section.

9.1 The Slicing Process

For Slice Files, a three-dimensional object is cut into horizontal slices and saved as a great collection of two-dimensional cross sections with a certain specified thickness. Parts or sections of all selected parts can be sliced with any layer size by dragging them from the parts section into the slices section in the project tree (Figure 9.1). Alternatively, you can select the part and choose "Slice Selected Parts" in the Extras menu. If more than one part is selected, all selected parts are sliced together. The part is then sliced into layers with a certain thickness which are parallel to the X-Y-plane (Figure 9.2).

Figure 9.1: To slice a part, move it into the slices section with drag & drop.
Three parameters must be set for the slicing process: The layer size determines the thickness of the slices, which directly influences the number of layers created (Figure 9.3). If you plan to build the part, it is recommended to adjust the layer size to your machine specifications.

"Start" and "Stop" determine the sliced section of the part. The values to be entered represent the coordinate value on the Z-axis of the planes where the slicing begins and stops. Everything between those planes is sliced. At the beginning, the sliced section includes all selected parts completely.

**Figure 9.3: Dialog box for slicing a part**

### 9.2 The Slices Section

When the part is sliced, the resulting slice is inserted into the slices section of the project tree and is automatically selected. Any time slices are selected, the Slice Commander is
activated. Changing slices in the Slice Commander does not have any influence on original three-dimensional parts in your project.

The viewing screen is replaced by a **slices screen**, where slices are displayed layer-by-layer. Slice viewing and handling options are available in the tabsheet, in the context menu of the screen (Figure 9.4) and in a Slices menu, which is added to the menu bar.

Previously saved slice files with various file formats can alternatively be opened and inserted into the project with the File Preview Browser or with the option "Open Slice File" in the context menu.

Just as parts in the normal mode, slices can also be assigned to **groups**. These are created in the context menu and appear as a directory in the "Slices" section of the project tree. Slices can be moved into and out of groups by **drag & drop**, in the same way as parts (chapter 5.5)

If you want to **remove slices**, you can either double click on the red X to the right of the slice in the project tree, choose "Remove" in the context menu or simply press Delete when the slice is selected. If you choose "Remove all", all slices will be removed and the Slice Commander will be emptied. For further information about the Export functions in the Slice commander, take a look at chapter Error! Reference source not found.

Slices can be **duplicated** in the context menu. That way, an exact copy of the slice file is inserted to the right of the original.

### 9.3 Active Slice File

In the tabsheet, information can be viewed on the selected slice file. It contains the **name** of the current slice, the size of the whole part, its **area, contour** length and **hatches** length. **Min. Z** and **Max. Z** give you the exact position along the axis.

The scroll bar on the left regulates the **display of layers from top to bottom**. You can also look at the toolpath of a certain slice. To do so check the **Animate Toolpath** box and scroll to the slice. The animation will then be visible on the screen. If a **slice animation** is started, the Slice Commander automatically browses through the slices at a chosen speed (Layers per Second).
The **global information** specifies the current layer and overall layer count of **all slice files** in the Slice Commander (unlike the active slice file, where only the specifications for one file is given). Different files can share layers, if they have common Z-coordinates.

If the box **Preview Calculations** at the bottom of the tabsheet is ticked, the result of conducted operations with slices is shown. However, this can require much calculation time when you scroll through the slices.

### 9.4 Slice Selection and Handling

The Slice Commander contains several functions for the **viewing, handling and editing of slices**. All of these functions are applied to all layers of the slice.

#### 9.4.1 Select Slices

As parts in the normal mode, slices must be **selected**, if you want to edit them. A
selection of slices is assembled similar to the selection of parts in the normal mode (chapter 5.2). You select slices by clicking on their edges, on their names in the project tree or by dragging a selection rectangle around the slices you want to select. Selected slices are always framed by a green, rectangular selection box, with highlighted corners and centers of edges.

If you select slices in the screen and hold the Shift key, slices are added to the selection by clicking on them. If you hold Ctrl, slices can be both added to or removed from the selection by clicking on them. If you hold Shift and select slices in the project tree, clicking on a slice file selects all slices in the list between the selected slice and the slice you click on.

### 9.4.2 Slice Viewing Options

The most obvious difference of the Slice Commander to the normal mode is that the screen is underlain by a two-dimensional coordinate system, showing the slices in the X-Y-plane. If the option "Show platform" is activated in the View menu, the outline of the platform is shown in the slices screen (Figure 9.5). This is very helpful when you position your slices and prepare you build data for prints, especially combined with the option "Show Outbox" (see below). The platform can only be seen in layers where it really is.

Below this screen, the position of the mouse cursor is specified (Figure 9.6), whereas the position on the Z-axis depends on which slice you are watching (changed with the scroll bar in the context area).
Figure 9.5: The screen of the Slice Commander with the coordinate system, the platform and four slice files with their outbox. Thanks to the outbox of the top left slice, you can see that this slice may stand out of the platform.

Figure 9.6: The coordinates of the mouse cursor, as specified below the viewing screen.

Zoom Options for Slices
As the slices are two-dimensional, it is not necessary and not possible to change the perspective. But apart from this, the viewing of slices in the slice screen works very similar to those in the main screen.
You can shift the view by holding the central mouse button and moving the mouse. If you do not have a central mouse button, hold Shift and the right mouse button. With the scroll button of the mouse, you can zoom in and out. If you do not have a scroll button, hold both Ctrl and the right mouse button and move the mouse up and down.
Also, you can use one of four default zoom options available in the toolbar: Zoom on all selected files, zoom to all slice files or zoom to a selection rectangle you draw with your left mouse button.

Visualizations
For the visualization of the slices, you can show and hide slices, change their color and three options in the context menu.
Slices can be hidden or shown by clicking on the eye next to the slice’s name in the project tree or in the context menu. Hiding slices that do not need attention for the moment can be helpful to keep, if you have many different slices.
The color can be changed with an option in the context menu. It’s exactly as with three-dimensional parts in the standard module (chapters 5.6, 9.2).
In the context menu after right-clicking on a selected slice, you find the following visualization options (Figure 9.7):
The outbox is the border of a slice file. It is always rectangular, regardless of the shape of the slices, and is adjusted to the layer with the widest expansion. If Show Outbox is activated, the outbox is represented by a dashed line. This is especially interesting, when parts are not selected. Otherwise the selection box may cover the outbox.

With Show Points, all corner points of contours and all end points of hatches are highlighted. This can include points on straight lines, as in the slicing process, a point is inserted at every place where in the original three-dimensional part a triangle edge was running over a surface.

Show Filling fills the contours of a slice with a very fine grid. In the settings, you can edit the grid size of the filling and you can choose to display only the horizontal or only the vertical lines. With default settings, the grid size is very small, and the filling looks like one colored surface, if you do not zoom in (Figure 9.8).

![Figure 9.7: Left: Selection box (outside) and outbox (inside) of a rotated slice. Center: Show Points. Right: Show Filling.](image)

**Figure 9.7:** Left: Selection box (outside) and outbox (inside) of a rotated slice. Center: Show Points. Right: Show Filling.

![Figure 9.8: Zoom in to see the grid lines the filling.](image)

**Figure 9.8:** Zoom in to see the grid lines the filling.

### 9.4.3 Move, Rotate, Scale and Mirror Slices

The positioning of slices is very similar to the positioning of three-dimensional parts. These operations can be conducted either by drag & drop or by inserting specific values in a dialog box (Figure 9.10). If you move parts by drag & drop, the values for the scale, translation and rotation are updated live in the tabsheet as you move the mouse.

Selected slices can be moved around on the X-Y-plane by drag & drop, clicking either on the selection box or on the green square in the center of the slice.
Alternatively, by clicking on the "Move Slices"-icon in the toolbar or choosing "Move" in the context menu, a dialog box for manual transformations is opened. At the top of the dialog, the current selection, the part’s position and size are specified. Then you can set specific coordinates along all three axes for moving the slice. If the box "relative translation" is ticked, the coordinates you enter represent the direction of the movement from the current position. Or you can enter the coordinates for the absolute position with reference to the origin with the X- and Y-coordinates zero (Figure 9.9). If the box Keep window open is ticked, you can apply the changes by "Translate", the dialog will stay open and you immediately can move the part again.

![Figure 9.9: Slice at zero coordinates](image)

The rotation of slices can be performed by clicking on the corners of the selection box, holding the left mouse button and moving the mouse. If you hold Ctrl, the slices are rotated in 10° steps. If you hold Shift, they are rotated in 45° steps. With the "Rotate Slices"-icon in the toolbar or the option "Rotate" in the context menu, you get the dialog box, just like in the three-dimensional default mode. You get the main information about the part again and you can specify an angle of clockwise rotation. If the box Keep window open is ticked, you can apply the changes by "Rotate", the dialog will stay open and you immediately can rotate the part again.

Similarly, slices can be scaled by drag & drop or with help of the Manual Transformation dialog box. Click on the center of the selection box edges and drag them outwards or inwards to enlarge or shrink the slice. If you hold Ctrl, the center of the slice stays in the same position. If not, the opposite edge of the selection box keeps its coordinates.
With the option "Scale" in the toolbar or in the context menu, you can set specific scaling factors for the X- and Y- axes and for the Z-axis. First, you get information about the current selection, the part’s position, size and the scale center. Then enter the scaling parameter: a scaling factor (e.g. factor 2 makes the part twice as big), by a percentage or by defining the actual size. Slices are always scaled evenly in both the X- and the Y-direction. With the "Fix scaling ratio" box ticked, the dimensions of all three axes are scaled by an equal factor and consequently makes the whole part bigger or smaller. If it’s not ticked, the values of X- and Z-axis can be changed. X- and Y-axis will always be kept synchronous. If the box Keep window open is ticked, you can apply the changes by "Scale", the dialog will stay open and you immediately can change the part’s size again.

The mirroring function can be found in the submenu "Extended" in the context menu. As in the handling functions before, you can check the current selection, its position and size. Then decide whether you want to mirror it along the X- or the Y-Axis. Additionally, it’s also possible to define you own X- or Y-value for a specific mirroring plane. The slices will be mirrored along the Y-axis and placed in the same position as the original part. If you want it to be mirrored along the X-axis, simply rotate the part by 180° around the Z-axis. To keep the original next to the mirrored part, uncheck the respective box "Remove original part". If you want to make several changes after another, it’s recommended to Keep the window open. Now apply the calculations by clicking on "Mirror".
9.4.4 Merging and Grouping

When two parts or more are selected, the slices can be unified to one single part. The original shapes will remain and can be separated again later.

In the submenu "Extended" in the context menu, there’s the option **Merge Slices**: The slices will become one slice file which includes all contours of the original. Overlapping contours will remain.

With **Clear grouping** you can reverse this unification. And very importantly, editing operations you conduct with slices, such as merging slices, can also be undone by this function. Thereafter, the slice resulting from the operation is removed and a new group is created which will contain the original slices.

9.5 Edit Slices

Many of these functions are also available in the three-dimensional data management. However, in the Slice Commander, you have the advantage that calculations are performed much quicker, as complex 3D-tasks are replaced by 2D-tasks. This reduces the complexity of the data handling.
The result of editing slices can be seen when the box **Preview Calculations** at the bottom of the tabsheet is ticked. However, this can require much calculation time when you scroll through the slices. If "Preview Calculations" is not ticked, the original slices are displayed until the calculations are applied.

The same calculations can be ultimately implemented by choosing **Apply Calculations** in the context menu. Please note that calculations are applied automatically when you export the slice.

As long as the calculations have not yet been applied, editing operations with slices can be undone by selecting **Clear grouping** in the context menu. The slice resulting from the operation is removed and a new group is created which will contain the original slices.

### 9.5.1 Boolean Operations & Removing Self-Intersections

If one part is selected that contains self-intersections, you can also remove them in the slices. Or if two or more parts are selected, you can perform Boolean operations. Find both functions in the context menu in the submenu Extended. If one part is selected, you’ll find the "Remove self-intersections" button, if more parts are selected, the "Boolean Operation" button will be displayed instead.

The **Boolean Operation** allows you to merge overlapping slices, create an intersection, or subtract one slice from the other (Figure 9.11). A dialog box appears in which the selected slice files can be assigned to the two fields "Add" and "Subtract". At the beginning, all slices are in "Add". If you click on a slice and then click on the arrow pointing to the other field, the file is moved there. If you click on the X, the selected file is removed.

To unify slices, all slices have to be in the left field "Add". Execute the unification with the button "Boolean" (Figure 9.12). For an **intersection of selected slices**, choose "Create Intersection" in the context menu instead of "Boolean Operation". The resulting slice includes only the overlapping sections of all selected slices.
To **subtract slices** from others, you have to move those files you want to subtract into the right field in the dialog box of the Boolean operations. The software creates a unification of all slices in the "Add" field and subtracts the area of those slices in the "Subtract" field from that unification. Overlapping areas are deleted (Figure 9.13). To immediately see the result of the Boolean operation, tick the box **Preview Calculations** in the tabsheet (=default). The calculations are applied automatically when you export the file or with the function "Apply calculations" in the context menu (see above).

If triangles or surfaces of one part cut through each other, this is called a **self-intersection**. Select the part, right-click and open the Extras-menu. With a click on Remove self-intersections, you’ll split of the intersections and the new inner shells and double surfaces will be removed. The outer surfaces are then reconnected and a valid shell is being created.
Figure 9.13: Top: Settings for a Boolean Operation. The box shall be subtracted from the cylinder. Bottom left: The two overlapping slices before the operation. Bottom right: The resulting slice.

Create Offsets of Slices

With the Slice Commander, you can create two-dimensional offsets of slices. They can be used, for example, to compensate for expected inaccuracies during production with a machine.

With the option Create Offset in the context and Extras menu, you can create either an inner or an outer offset of the slice. It creates a new slice, of which the layers are based on the shape of the original layers, only that they are placed either within or without the original. In a dialog box, you can enter the preferred distance to the original contours, you can edit the roundness for curves of the offset, where it goes around corners of the original, and you can choose between an inner and an outer offset (Figure 9.14)
This roundness is only relevant when it is necessary that the offset forms a curve, which is
the case with outer corners for outer offsets and with corners with a reflex angle for
inner offsets (corners projecting inside). If the offset line lies on the inside of the corner
of the original, a new corner is created with an identical angle (Figure 9.15).

The roundness angle represents the maximum angle of two adjacent points of the offset, with
the original corner point as apex of the angle. Consequently, the offset curve becomes
rounder and more precise, if the maximum angle is reduced (Figure 9.16).
When you click on "OK", a **raw offset** is created. This consists only of hatches parallel to the original hatches. Netfabb also displays lines connecting the end points of the offset hatches with the corner points of the original contour (Figure 9.17). If there goes around the outside of corners, the additional hatches connecting the open ends (according to your roundness settings) are also added to the offset.

If "Preview Calculations" is ticked, a preview of the finished offset is displayed instead of the raw offset. This offset is finished, if you apply the calculation in the context menu. Calculations are applied automatically when you export the slice (see above). So, you can wait with applying these calculations, which can take some time and disrupt your workflow with complicated slice data, until you export.

![Figure 9.17: Raw offsets](image)

### 9.5.2 Point Reduction

This feature removes unnecessary points from a slice and thereby reduces the data volume of the file. Often, these are points between hatches with a flat angle, which possibly result from triangle edges on flat surfaces of three-dimensional files (Figure 9.18). At every place where the slice layer comes across such a triangle edge, a corner point is added and a new hatch is started.
You can see the points on your slice, when you activated the function "Show points" (chapter 9.4.2).
netfabb calculates how far each point is from a potential hatch line connecting the two adjacent points. If the distance is below a certain value, that point is removed and the new line is inserted. The maximum distance of the old point to the new line is defined by the **maximum deformation** you insert in the dialog box before conducting the operation (Figure 9.19).

![Figure 9.19: Edit and confirm the maximum deformation in this dialog box.](image)

The result of the point reduction can only be seen with the option "Preview calculations" the point reduction is not finally implemented, until you "Apply calculations". When you export your slice, calculations are applied automatically.
This function has the purpose to reduce the complexity of slices, as the point reduction eases lengthy calculations during export and during production, often without or hardly changing the actual shape (Figure 9.20). Round curves, however, may be made less accurate, so you should take care not to fill in a too high maximum deformation.
Figure 9.20: Here, the curve of the body is slightly less accurate after the point reduction.

9.6 Edit Filling

9.6.1 Create Filling

There are machines on the market, which can read your simply sliced files and fill the part automatically. But there are also machines that need an exact toolpath for the laser and therefore you’ll have to create a specific filling. Choose Create Filling in the Extras submenu. With some production methods, you can adapt exposure strategy during production without changing the actual shape of a part.

In the dialog box, there are three hatch modes available. With the simple hatching the slices will be filled with straight, solid lines. The Quad Islands mode divides each layer into squares and fills them alternately with vertical and horizontal lines.

The third mode, the Stripe hatching, adds dashed lines as filling to the part. For the simple mode, you can insert the Hatch distance (Figure 9.21). To know the correct distance, it is important to know the specifications of your machine. The Quad Islands mode also requires the width and height of the quads. And for the stripe hatching, determine the hatch distance, stripe width and stripe gap. (Figure 9.21)
Figure 9.21: The dialog box for creating a filling.

The angle determines the direction of the hatches, referring to the X-axis with a clockwise rotation. Thus, if you leave 0°, the hatches will be inserted along the X-axis. If you insert 90°, they will run along the Y-axis (Figure 9.22).

The Rotation per Layer can be used to give the hatches of different layers different directions. In that case, only the first layer of hatches has the angle specified above. After that, the angle changes with every layer (going upwards) by the degree you enter here (Figure 9.23).

If you increase the number for Filling only each ... layer, not every layer of the original contour will be filled. If you insert 2, for example, there will be one filling layer for every second contour layer.

Note: The Rotation per Layer refers to the filling layers, independently from the number of contour layers in between.

The Translation per Layer determines, if and how far the hatches are shifted with
Figure 9.22: A round contour with filling: first, a filling with an angle of 0°, then with an angle of 45°.

Figure 9.23: Two consecutive layers of the same slice file with a rotation of 20° per layer.

each layer. If you insert zero, the hatches of the slice layers will be on top of each other. If you insert 1.0, the hatch lines are upwards shifted by one mm with each layer, going from the top to the bottom layer.

With the rotation and the translation per layer, you can avoid that the filling hatches are exactly on top of each other. With some production methods, this could lead to lower part quality and instability.

Some machines, for example metal sinter machines, require a specific direction the laser traces the filling. The **Sort type** controls this tool path of the laser and you can choose between the five options no sorting or to sort from right to left, from left to right, from top to bottom and from bottom to top.
The filling is inserted as new slice file when you click on **OK**. It is treated as independent object in the Slice Commander and in the project tree (Figure 9.24).

![Figure 9.24: Here, the filling is moved out of the contour as an independent slice.](image)

### 9.6.2 Hatch cutting

Whenever a contour protrudes into a filling, you can cut the filling along this contour:

- Select both parts, open the context menu, the Extras submenu and click on Hatch cutting. As a result a new hatch file will be created. (Figure 9.25)

![Figure 9.25: Left: Blue contours protrude into the black filling. Right: Filling was cut along the blue contours and results in two filling sections.](image)
9.6.3 Convert contours/hatches

This feature is available in the submenu "Extra" in the context-menu. As described above, there are Additive Manufacturing machines that automatically fill your slices. If you decidedly don’t want any filling, it’s recommended to convert the contours into hatches. The contours now behave like the hatches of a filling and can’t be filled themselves again.

In the Hatch conversion dialog, you can perform the calculations either way: from contours to hatches or from hatches to contours. A high accuracy creates an exact calculation, but may lead to long calculation times.

It’s also possible to filter Contours/Hatches, which means that everything you have selected will be checked for certain parameters and those contours/hatches that fulfill the parameters will be copied. You can either preserve hatches and/or closed contours. Open contours can be retained too, but if you want to actually build them you’ll have to convert them into hatches afterwards.

Figure 9.26: Left: Part with hatches and contours, Right: after filtering with "preserve hatches"

The function Connect Contours is comparable to the Stitching in the Repair mode. Open edges that are lying close to each other will be connected. With Filter Small Contours, very tiny and unnecessary contours won’t be copied. You can define the Minimum Contour Area in cm³.
9.7 Export Slice Information

It is possible to export the contour and area data of the sliced project into a CSV file. To do so click on the Slices tab in the toolbar and a dialog will open where you can save the file to your preferred destination. It contains information on Z-Height, Area, Contours and Hatches for each individual layer.

![Figure 9.27: The export will create a CSV file where information about Z-Height, Area, Contours and Hatches is being stored in separate columns.](image)

10 Settings (partially in netfabb Private/Pro only)

Settings for netfabb can be altered in the Settings menu. General settings concern all kinds of aspects of the software, including the coloration of all visualizations, and can be changed in a separate window, if you choose "Settings". If you click on "Edit File Associations", you can choose which file types shall be linked to netfabb.

![Figure 10.1: The settings menu](image)

10.1 General Settings

The settings for netfabb can be changed in the Settings menu. After clicking on "Settings", a window appears where settings for many different aspects of the software can be altered (Figure 10.2). The settings can either be changed in a dropdown
menu, by insertion of values or names, or by opening a dialog box with a double-click on the current setting.

**List of General Settings**

**Language:**
Current available languages are English, German, Russian, Czech, Chinese, Japanese and Spanish.

**Unit of Length:**
In this dropdown menu, you can choose between mm and inch as standard unit of length for your netfabb installation.

**Show Icons in Menu:**
If you deactivate this option, no icons are shown in the menus and context menus of netfabb. Shown icons are always to the left of the menu functions.

**Proxy Settings:**
In the proxy settings, you first have to choose, if you want to use admin settings or not. If you do so, the settings can only be changed by the administrator in the admin settings at the top. If not, you can change the proxy settings here.

You may need an internet connection for updates or accessing the netfabb online help. If your internet connection is based on proxies, you can change your Proxy-Settings, Proxy-Server, Proxy-Username and Proxy-Password in the respective fields. If you have a direct internet connection, the other proxy settings are not necessary. If you have a Proxy server without authentication, no username and password have to be entered.

**License Settings:**
If you have more than one license of netfabb, choose the one which you prefer to use.

- **License type:** for a floating license, choose “network license”
- **Hostname/IP:** enter the hostname OR the IP where your license is stored
- **Backup Hostname/IP:** enter the hostname OR the IP (the opposite of what you chose above!) in order to have a backup if one of them is not available.
- **Use add-ons:** Choose which add-ons you want to use from your license. For example: If your company has a license from a netfabb Professional with CAD
Import, but you only need the Professional, choose “No” in order to keep the CAD Import available for your colleagues.

**Activate netfabb Crash Logger:**
If you run across any errors, the Crash Logger provides further information. A small extra tool is required though, please contact support@netfabb.com.

**Rotation with mouse, discretation degree:**
When rotating manually, hold ALT and the part will be rotated by steps of this angle.

**Rotation X, Y, Z degree:**
When rotating by the x, y or z key the part will be rotated by steps of this angle.

**Colors:**
Set the colors for platform, parts and modules.

**Default-Platformshape:**
You can toggle between a cubical or a round platform shape here.

**Default Platform size:**
The size of the platform is best adjusted to the size of the build platform in your machine.

**Zoom to newly created part:**
Whenever you have created a part, the display will zoom into it.

**Automatic check for erroneous parts:**
If you do not always check for parts with errors, there will not be any warning signs, if you have damaged or faulty parts in your project.

**Import and export**

**Resolve Windows Link File Names:**
This setting determines the naming of parts which are opened with a .lnk link file that links to a 3D file. If it is inactive, the part in the project will be named as the .lnk file, if it is active it will be named as the 3D file.

**Ask for saving while deleting part:**
If you remove a part, netfabb will ask if you’re sure about this.

**Change LOD for all opened files:**
All parts and project will automatically be opened with this value.
**Restore LOD after Project Loading:**
Whenever working with a lower Level of Detail in order to speed up processing, it’s possible to save it and continue working with this LOD next time.

**Confirm after project saving:**
If this option is activated and you save a project, you’ll get a confirmation when the process has been finished.

**Always use file preview:**
If you select "Yes", the File Preview Browser will start every time you want to open a file.

**Use Advanced file import:**
If this is activated, a dialog box appears where you can change the settings for the import and stitch, scale and duplicate parts (see chapter 3.2).

**Display Settings**

**Strength of background gradient:**
In your background, there is a color gradient gradually changing from bright at the top of the viewing screen to dark at the bottom of the viewing screen. The default color is white, which becomes grey at the bottom.

**Use enhanced display functions (OpenGL3.3):**
The enhanced display functions enables a prettier rendering of the parts. If you have troubles with displaying your parts, set this function to No.

**Level of detail:**
Use the simple mode for quicker calculation or the advanced mode for a more precise view of the part.

**Highlight center of platform:**
If you choose Yes, a large X will indicate the center of the platform.

**Coordinate System:**
The coordinate system in the bottom left of the viewing screen, can be altered in size. If the planes are shown, their minimum and maximum size, as well as their thickness can be specified. The size of the planes in the program varies between the minimum and maximum value, depending on the current perspective, with planes in the background
always displayed larger than those in the foreground. The planes, if displayed, can be used for changing the perspective.

**Slice Commander**

In case you visualize the prehatches of slices with the option **Show Filling**, you can edit the distance of the grid lines here. Additionally, you can choose if you want to have grid lines along the X-axis, the Y-axis or along both axes (Figure 10.24). Also, you can edit the default tolerance for **point reductions**. You can also edit the tolerance at every single point reduction.

![Figure 10.2: The prehatches of a slice with grid lines along both axes (left) and grid lines only along Y-axis (right).](image)

**Parts Library**

In the Parts Library Section, you can edit the default settings for all parameters of all primitive objects you can add to the project.

**Part Repair**

For the part repair (Figure 10.3), it is possible to change the default stitch tolerance. You do not necessarily have to use that value for the stitching of triangles, as you can set the tolerance for every single stitching.

The minimum edge length for good faces determines which triangles are defined as "degenerated" in the repair module. All triangles with a height lower than this value can be displayed in orange and are deleted with the function **Remove degenerate faces** (see chapter 7.5.6) the orange highlighting of degenerate triangles in the repair module. Triangles with an edge shorter than the specified value are marked (Figure 10.3).
165

For the measuring, you can choose in dropdown menus, which measuring mode and which option for setting anchor points shall be set when you start the measuring module.

**Part Renaming**

The part renaming determines the name parts get automatically after they are modified. The name of the original is always part of the new name. To change renaming settings, double-click on a function in the list, or click on the button "..." which appears to the right of the function after you click on it once (Figure 10.4). A dialog appears to change the automatic renaming. You can insert what will be added before or after the part name in the text fields left and right of "part name". Below, you can see a preview of how your parts will be named. "Part name" always refers to the name of the original part. With the button "Set to defaults" at the bottom of the dialog, you can restore the default naming for that particular function (Figure 10.5). The default setting for repaired parts, for example, is that ",(repaired)" is added to the original part name.

"Create Hollow Part", "Inner Offset", "Outer Offset" and "Hollowing Shell" refer to the respective options for the function "Create shell". "Group of shells of one part" and "Group of shells of multiple parts" stand for the group names of the groups into which the shells are moved with "Shells to parts". Similarly, "Group of cut parts" refers to the group into which cut parts are moved.
Figure 10.4: The list of functions for which the automatic part renaming can be altered.

For functions which may create several parts at once or which process several parts at once, such as "Duplicate", "Shells to Parts", "Cut parts" and "Merge parts", there is the additional field "XX". This is only enabled, if the box below is ticked. If several parts are created at once, the "XX" stands for a number which will be inserted for each part name. If you duplicate a part, for example, the copies will by default be named "Part name_c00", "Part name_c01", "Part name_c02" and so on. If several parts are processed by a function, the "XX" stands for the number of parts processed, as for example in "Merge of 2 parts".

Any changed renaming options are written in italic letters. If you click on the last line "Defaults", a button appears with which you can restore the default naming settings for all functions.
10.2 Change Colors

The color can be changed in netfabb for parts, slices and many other objects and all kinds of visualizations. They are always changed in a dialog box, which provides every shade of every color of the whole spectrum. For parts and slices, the color can be changed via the context menu or the menu bar. Other colorations are changed via dialog boxes or in the settings.

In the dialog box for changing the color you have several options (Figure 10.6): Firstly, you can click on a basic color. These are part of the installation of the software. Secondly, you can click anywhere on the spectrum to the right and the respective color is chosen. Then, you can alter the brightness in a bar to the right. That way, any color can be created. If the brightness is at the top or bottom of the bar, the color will always be white or black.

Below the spectrum, in the field Color|Solid, the color you have chosen is displayed. Next to that field, values of the hue, the saturation, the lumination and the intensity of red, green and blue are specified. The values are adjusted automatically when you change the color, but you can also change the color here by manually entering new values. The change of color is confirmed, when you click "OK".
To create user-defined colors, click on one of the custom colors. After installation, these are all black. Then, choose a color in the spectrum and define its brightness. Finally, click on "Add to Custom Colors" to insert the color into the custom color field you have selected.

In the settings, you can edit the default settings for every kind of coloration by double-clicking on the respective color. This includes the background in the viewing screen, the platform, collisions, cuts, the planes and origin of the coordinate system, the color of selected parts and of back faces, the coloration of parts during Boolean operations, the default colors for added parts, the preview and blackface colors for the File Preview Browser and the iPhone part and blackface color.

In the Slice Commander settings, the colors for the background and the default colors for added slices in general can be set.

In the Part Repair settings, you can change the color of the outside and inside of both unselected and selected faces, of boundary edges, degenerate faces, self-intersections, double surfaces, edges, the triangle mesh, as well as the preview of a surface and selected edges when adding triangles, the face preview and the edge preview when adding nodes and the extrusion lines and the extrusion in the feature Extrude Surfaces.

Figure 10.6: The dialog box for changing colors.
Figure 10.7: In the settings, every kind of coloration can be altered.

For the measuring and the test module, you can set the color of tested measurements and values that are within or without your tolerance (test module), the part in the screen, the lines and the faces of previewed values in the screen and the text and the background of the measuring point.

10.3 Edit File Associations

File associations can be changed via the Settings menu. Here, all file types selected by ticking their box on the left are automatically linked to netfabb. If you open a file with such a file type, a new netfabb window opens containing the file. You can also activate ("All") or deactivate ("None") all file types at once or you can reset your settings to the original status. Settings must be saved to become active. You can save them for all users or only for yourself (Figure 10.8).
Figure 10.8: The file associations window
11 Appendix (for Report Creation in Pro)

See all parameters for creating your own report templates in the Pentaho Report Designer, see chapter 3.2.4.

11.1 Image field parameters

<table>
<thead>
<tr>
<th>Image Name</th>
<th>View</th>
</tr>
</thead>
<tbody>
<tr>
<td>NETFABB_PLATFORMSCREENSHOT.bmp</td>
<td>presentation mode: similar to isometric view, but from a little lower and further from the right.</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_BACK.bmp</td>
<td>view from the back of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_BOTTOM.bmp</td>
<td>view from the bottom of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_CUSTOM.bmp</td>
<td>view like it was at the time of the report generation</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_FRONT.bmp</td>
<td>view from the front of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_ISO.bmp</td>
<td>Isometric view</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_LEFT.bmp</td>
<td>view from the left side of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_RIGHT.bmp</td>
<td>view from the right side of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORMVIEW_TOP.bmp</td>
<td>view from the top of the platform</td>
</tr>
</tbody>
</table>

11.2 Text field parameters

<table>
<thead>
<tr>
<th>Field name</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>NETFABB_DATE</td>
<td>Date of the report generation in the format DD.MM.YYYY</td>
</tr>
<tr>
<td>NETFABB_DATETIME</td>
<td>Date and time of the report generation in the format YYYY-MM-DD HH:MM</td>
</tr>
<tr>
<td>NETFABB_LENGTHUNIT</td>
<td>Unit string of all length fields in the report (mm or inch)</td>
</tr>
<tr>
<td>NETFABB_AREAUNIT</td>
<td>Unit string of all area fields in the report (mm² or inch²)</td>
</tr>
<tr>
<td>NETFABB_VOLUMEUNIT</td>
<td>Unit string of all volume fields in the report (mm³ or inch³)</td>
</tr>
<tr>
<td>NETFABB_PARTCOUNT</td>
<td>Number of parts on the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_NAME</td>
<td>Name of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_SURFACE</td>
<td>Surface area of all parts on the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_VOLUME</td>
<td>Volume of all parts on the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_ISSANE</td>
<td>Check if platform is sane (true or false)</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXMINX</td>
<td>Minimal X coordinate of the outbox of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXMINY</td>
<td>Minimal Y coordinate of the outbox of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXMINZ</td>
<td>Minimal Z coordinate of the outbox of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXMAXX</td>
<td>Maximal X coordinate of the outbox of the platform</td>
</tr>
<tr>
<td>Field name</td>
<td>Content</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXMAXY</td>
<td>Maximal Y coordinate of the outbox of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXMAXZ</td>
<td>Maximal Z coordinate of the outbox of the platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXSIZEX</td>
<td>Size of the Outbox on the X Axis of the Platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXSIZEY</td>
<td>Size of the Outbox on the Y Axis of the Platform</td>
</tr>
<tr>
<td>NETFABB_PLATFORM_OUTBOXSIZEZ</td>
<td>Size of the Outbox on the Z Axis of the Platform</td>
</tr>
<tr>
<td>NETFABB_PART_NODECOUNT</td>
<td>Count of Nodes</td>
</tr>
<tr>
<td>NETFABB_PART_EDGECOUNT</td>
<td>Count of Edges</td>
</tr>
<tr>
<td>NETFABB_PART_FACECOUNT</td>
<td>Count of Faces</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXMINX</td>
<td>Minimal X Coordinate of the Outbox</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXMINY</td>
<td>Minimal Y Coordinate of the Outbox</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXMINZ</td>
<td>Minimal Z Coordinate of the Outbox</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXMAXX</td>
<td>Maximal X Coordinate of the Outbox</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXMAXY</td>
<td>Maximal Y Coordinate of the Outbox</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXMAXZ</td>
<td>Maximal Z Coordinate of the Outbox</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXSIZEX</td>
<td>Size of the Outbox on the X Axis</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXSIZEY</td>
<td>Size of the Outbox on the Y Axis</td>
</tr>
<tr>
<td>NETFABB_PART_OUTBOXSIZEZ</td>
<td>Size of the Outbox on the Z Axis</td>
</tr>
<tr>
<td>NETFABB_PART_VOLUME</td>
<td>Volume of the Part</td>
</tr>
<tr>
<td>NETFABB_PART_AREA</td>
<td>Area of the Part</td>
</tr>
<tr>
<td>NETFABB_PART_ISOK</td>
<td>Check if the Part is sane (true or false)</td>
</tr>
<tr>
<td>NETFABB_PART_SHELLCOUNT</td>
<td>Count of Shells in Part</td>
</tr>
<tr>
<td>NETFABB_PART_SURFACEISCLOSED</td>
<td>Check if the Surface is closed</td>
</tr>
<tr>
<td>NETFABB_PART_BOUNDARYEDGECOUNT</td>
<td>Number of boundary edges (a boundary edge has just one face)</td>
</tr>
<tr>
<td>NETFABB_PART_BADEDGECOUNT</td>
<td>Number of Bad Edges</td>
</tr>
<tr>
<td>NETFABB_PART_BOUNDARYLENGTH</td>
<td>Length of all boundary edges (a boundary edge has just one face)</td>
</tr>
<tr>
<td>NETFABB_PART_SURFACEISORIENTABLE</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_HOLECOUNT</td>
<td>Number of holes in the part</td>
</tr>
<tr>
<td>NETFABB_PART_FLIPPEDTRIANGLES</td>
<td>Number of flipped triangles in the part</td>
</tr>
<tr>
<td>NETFABB_PART_EDGESPERPOINT_MIN</td>
<td>Minimal number of edges at a point</td>
</tr>
<tr>
<td>NETFABB_PART_EDGESPERPOINT_MAX</td>
<td>Maximal number of edges at a point</td>
</tr>
<tr>
<td>NETFABB_PART_EDGESPERPOINT_MEAN</td>
<td>Average number of edges at a point</td>
</tr>
<tr>
<td>NETFABB_PART_EDGESPERPOINT_STDDEV</td>
<td>Normal distribution of edges at points</td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLESPEREDGE_MIN</td>
<td>Minimal number of triangles at an edge</td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLESPEREDGE_MAX</td>
<td>Maximal number of triangles at an edge</td>
</tr>
<tr>
<td>Field name</td>
<td>Content</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLESPEREDGE_MEAN</td>
<td>Average number of triangles at an edge</td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLESPEREDGE_STDDEV</td>
<td>Normal distribution of triangles at edges</td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLEQUALITY_MIN</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLEQUALITY_MAX</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLEQUALITY_MEAN</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_TRIANGLEQUALITY_STDDEV</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_EDGESLENGTH_MIN</td>
<td>Minimal edge length</td>
</tr>
<tr>
<td>NETFABB_PART_EDGESLENGTH_MAX</td>
<td>Maximal edge length</td>
</tr>
<tr>
<td>NETFABB_PART_EDGESLENGTH_MEAN</td>
<td>Average edge length</td>
</tr>
<tr>
<td>NETFABB_PART_EDGESLENGTH_STDDEV</td>
<td>Normal distribution of the edge length</td>
</tr>
<tr>
<td>NETFABB_PART_AVERAGEWALLTHICKNESS</td>
<td>Average Wall thickness</td>
</tr>
<tr>
<td>NETFABB_PART_CENTEROFGRAVITYX</td>
<td>X coordinate of the centre of gravity</td>
</tr>
<tr>
<td>NETFABB_PART_CENTEROFGRAVITYY</td>
<td>Y coordinate of the centre of gravity</td>
</tr>
<tr>
<td>NETFABB_PART_CENTEROFGRAVITYZ</td>
<td>Z coordinate of the centre of gravity</td>
</tr>
<tr>
<td>NETFABB_PART_WALLTHICKNESS_CRITICALDISTANCE</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_WALLTHICKNESS_CRITICALSURFACE</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_WALLTHICKNESS_THRESHOLDRESULT</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_WALLTHICKNESS_AREABELOWTHRESHOLD</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_WALLTHICKNESS_NUMBEROFCLUSTERS</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_WALLTHICKNESS_AREAOFLARGESTCLUSTER</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_SHADOWAREA</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_UPDOWNSKIN_UPSKINANGLE</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_UPDOWNSKIN_DOWNSKINANGLE</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_UPDOWNSKIN_MINCOMPONENTSIZE</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_UPDOWNSKIN_UPSKINAREA</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_UPDOWNSKIN_DOWNSKINARAE</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_UPDOWNSKIN_DOWNSKINCOUNT</td>
<td></td>
</tr>
<tr>
<td>NETFABB_PART_UPDOWNSKIN_UPSKINCOUNT</td>
<td></td>
</tr>
</tbody>
</table>